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1. INTRODUCTION 

The Deployed Theater Accountability Software (DTAS) application provides the U.S. Army and 
the U.S. Marine Corps with a reliable, timely, and efficient mechanism for tracking and 
providing reporting visibility into the location and duty status of deployed Soldiers at both the 
Enterprise level (top of the system) and the unit level (bottom of the system).  This visibility is 
vital in determining war fighting capability. 
 
In support of the DTAS vision, this project controls the work effort to meet the following 
objectives: 

 Develop a standard Army system for deployed personnel accountability 
 Improve data quality 
 Establish a common picture 
 Perpetuate deployed personnel accountability 

 
DTAS enables commanders in deployed theaters to account for DoD personnel in their areas of 
operations by name (SSN), unit, location, and day.  DTAS comprises three components:  the 
Enterprise, Theater, and Mobile systems.   
 
The DTAS Enterprise system houses the central database, which contains soldier data obtained 
from eMILPO as well as information on current soldier location and duty status as entered into 
the Mobile systems and passed to the Enterprise system.  The Enterprise system also interfaces—
through a secure cross domain solution (CDS)/trusted gateway—with eMILPO and receives data 
from the Defense Manpower Data Center (DMDC) and Operational Data Store Enterprise 
(ODSE).  In addition, the Enterprise system includes an integration broker that manages the 
messaging among DTAS component systems.  The Enterprise system also houses a data 
warehouse that contains historical data for each deployed soldier, such as a transaction history of 
those attributes for which DTAS is the authoritative source.  Ad hoc reporting and the 
JPERSTAT are configured to run against the DTAS Enterprise data warehouse.   
 
The Theater system consists of the Theater Manager application and a core database.  The 
Theater database is a subset of the Enterprise system.  The Theater system communicates with 
both the Enterprise and Mobile systems.  Message Queuing is used for communications between 
the Theater and Enterprise systems.  The Theater system uses Web Services to support data 
communications with occasionally connected DTAS Mobile systems.  The Theater Manager 
application allows theater-level users to manage mobile systems and UIC structure.  The Theater 
system also provides reporting capabilities, such as the JPERSTAT report and support for ad hoc 
queries.   
 
The Mobile system provides the First Sergeant/Company (1SG/CO) level with a micro-database, 
reporting capabilities, and personnel accounting tools.  The Mobile database contains 
information on the soldier’s current location and duty status as well as a mini-record.  The 
Mobile system allows the user to update location, duty status, personnel information, Deployed 
Assigned Unit Identification Code (DASUIC), and Deployed Attached Unit Identification Code 
(DATUIC), and tour status.  In addition, the system provides several predefined, roster-based 
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reports.  The Mobile system is deployed on laptop computers and uses Web Services because 
these systems may only occasionally be connected to the network.  While a Mobile system is 
disconnected, any DTAS work performed is stored in a message in its micro-database.  When the 
Mobile system is connected, the stored messages are sent to the Theater via Web Services. 
 
Note:  DTAS displays the SSN for an individual in several instances, such as on the People tab 
screen.  The SSN has been removed from all screen captures contained in this document for 
privacy reasons.  Therefore, some screens will appear differently in the document than they will 
on your system:  For example, a table column that would be populated on your system will 
appear blank in the screen captures. 
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2. DTAS MENUS 

DTAS includes the following menu choices:  File, View, Tools, and Help.  Each menu provides 
you with a set of functions that enable you to exit the system, view synchronization data, etc. 

2.1 File Menu 

You may exit the DTAS application from the File menu.  To exit DTAS, select Exit from the 
File menu (or click the X in the upper right-hand corner of the window). 
 

 

Figure 2–1:  DTAS File Menu 

2.2 View Menu 

The View menu allows you to select the view for your branch of service.  The default view for 
the application is whichever DoD component was identified when your Mobile system was 
activated.  The menu provides you with the following options: 

 Army—This option allows you to select the Army view of the DTAS Mobile application. 
 Marine—This option allows you to select the Marine view of the DTAS Mobile 

application. 
 

 

Figure 2–2:  DTAS View Menu 

2.3 Tools Menu 

The Tools menu provides you with the following options: 
 Mass Assign Wizard…—The Mass Assign Wizard allows you to add personnel from a 

TPS TRN file, an eMILPO Load, or a .CSV file. 
 Mass Attach Wizard…—The Mass Attach Wizard allows you to attach personnel using 

a TPS TRN file, an eMILPO Load, or a .CSV file. 
 System Info…—The System Info provides information related to the system 

configuration, such as System POC Name, System POC Phone Number, System DUIC, 
and System Activation Date. 

 Deactivate System…—The Deactivate System function resets the theater system.  This 
function will delete all personnel from the database and delete theater-specific 
information. 

 View Synchronization Info…—This function allows you to view system messages and 
synchronization information. 
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 CSV File—This function allows you to create and edit an Excel spreadsheet that is saved 
as comma delimited file for upload via the Mass Assign Wizard. 

 WorkFlow…—This function allows you to read or delete notices of unit attachments and 
release from attachment. 

 Attachment Physical Location…—This functions allows you to update the physical 
location for those soldiers attached to your unit through a unit attachment. 

 Unit Release…—This function allows you to release units from attachment to your unit. 
 

 

Figure 2–3:  DTAS Tools Menu 

2.3.1 Mass Assign Wizard 

The Mass Assign Wizard function allows you to load data to your DTAS database using an 
eMILPO XML load file, a TPS TRN file, or a CSV file.  The XML and TRN files are created in 
eMILPO or TPS, respectively, and are saved to a floppy disk or other removable/transportable 
media.  To load data from a file, perform the following steps: 
1. Select Mass Assign Wizard… from the Tools menu.  DTAS displays the Mass Assign 

Wizard dialog. 
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Figure 2–4:  Mass Assign Wizard—Select a Source File 

2. Click the Select File button to select the file.  DTAS displays the Open dialog box.  Navigate 
to the folder location of the file you wish to upload.  Highlight the file and then click Open or 
double click on the file to select it.  DTAS displays the file name and path on the dialog and 
activates the Next button.  Click Next to proceed. 

 

 

Figure 2–5:  Mass Assign Wizard—Source File Selected 

Note:  If the file you select is not of the appropriate type (either an XML, a TRN, or a CSV 
file), DTAS displays a message informing you that the file is not in the proper format.  Click 
OK to return to the Mass Assign Wizard dialog. 
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Figure 2–6:  Mass Assign Wizard—File Error Message 

 
Note:  When adding personnel from a CSV file, the Mass Assign Wizard will not load 
records that are missing data or contain errors.  The Mass Assign Wizard will only load 
complete/accurate records; any records containing errors will not be loaded.  You will be 
unable to load information for these persons until you correct the errors.  If your CSV file 
contains errors, the system displays an error message (shown below) informing you that the 
file contains errors as well as the location of the error log file.   

 

 

Figure 2–7:  Mass Assign Wizard—CSV File Error Message 

 
The error log file provides information on what values are missing and in which record 
(corresponds to the rows of the spreadsheet).  To correct the CSV file:  From the Tools menu, 
select CSV File and then Edit (see Section 2.2.5, CSV File, for additional information).  
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Figure 2–8:  CSV File Error Log 

3. DTAS displays the Select People to Load dialog box.   
4. By default, all records are selected.  Click Select All to select all records or you can select 

individual records by clicking the check box to the left of each record to select individual 
records you wish to load.  You can also click Deselect All to deselect all the records or you 
can deselect individual records by clicking the checkbox to the left of the record.   

 

 

Figure 2–9:  Mass Assign Wizard—Select People to Load 

5. Click Next to proceed.  The application displays the Select Arrival Date/Time and Operation 
data (or if adding personnel from a CSV file, the Select Operation Data) dialog.   
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Figure 2–10:  Select Arrival Date/Time and Operation Data Dialog 

 

 

Figure 2–11:  Select Operation Data Dialog 

6. Select the name of the operation to which the personnel are being added from the Operation 
picklist.  This is a required field. 

7. The Arrival Date/Time picklist defaults to what has previously been entered for the arrival 
date and time (the Arrival Date/Time field is not displayed for CSV files).  If you enter an 
Arrival Date/Time that is 30 or more days old, DTAS enables the Re-enter Arrival 
Date/Time field and you must re-enter the arrival date and time.  Note:  The arrival date and 
time cannot be a date greater than 4 years old. 
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For CSV files, if the Arrival Date/Time in the file is not a valid arrival date and time, the 
Arrival Date/Time field defaults to the current system date and time. 

8. Click Next to proceed with the load process.  DTAS displays the Select Assigned and 
Physical Location dialog.   

 

 

Figure 2–12:  Mass Assign Wizard—Select Assigned and Physical Location (XML 
and TRN Files) 

 

 

Figure 2–13:  Mass Assign Wizard—Select Assigned and Physical Location  
(CSV Files) 

9. In the Assigned area, select an Assigned location from the Location picklist.  DTAS defaults 
the Date/Time field to the current date and time.  Note:  There is no Date/Time field on the 
Select Assigned and Physical Location dialog when loading CSV data. 
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10. In the Physical section, select the type of location from the Type picklist.   
11. Select a location from the Location picklist.  DTAS defaults this to the Assigned location you 

selected in the Assigned data entry area.  The Assigned and Physical locations can be 
different.   

12. Enter the Grid Zone Designator (this is two numbers and one letter); this is a required field.  
The Grid Square Identifier and Grid Zone Coordinates (this must consist of six or eight 
numbers) fields are populated with the identifier and coordinates associated with the Physical 
location selected.   

13. Click Next to proceed with the load process.  DTAS displays the Select Tour Status Data 
dialog, if the person or persons you have selected are a U.S. Army soldier.  (Note:  The 
Select Tour Status Data dialog is not displayed if the persons selected are other person 
types.) 

 

 

Figure 2–14:  Mass Assign Wizard—Select Tour Status Data 

14. Select the soldier’s tour status from the Tour Status picklist.  The picklist defaults to 
Temporary Change of Station. 

15. Select an appropriate value from the Tour Status Subtype picklist.  This is a required field. 
16. Select the appropriate date in the Date/Time field.  For XML and TRN files, the Date/Time 

field defaults to the Arrival Date/Time; for CSV files, the field defaults to the current system 
date/time.  You may enter the date by either using the calendar function or manually typing 
the date.  This is a required field. 

17. Enter the length of the tour in the Number of Days field.  The field defaults to 365.  Type the 
appropriate number of days for tour duration.  This is a required field. 

18. Click Finish to load the data into the database.   
19. Click Back to return to the previous step in the process. 
20. Click Cancel to exit the process without adding data. 
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2.3.2 Mass Attach Wizard 

The Mass Attach Wizard function allows you to load data to your DTAS database using an 
eMILPO XML load file, a TPS TRN file, or a CSV file.  The XML and TRN files are created in 
eMILPO or TPS, respectively, and are saved to a floppy disk or other removable/transportable 
media.  To load data from a file, perform the following steps: 
1. Select Mass Attach Wizard… from the Tools menu.  DTAS displays the Mass Attach Wizard 

dialog. 
 

 

Figure 2–15:  Mass Attach Wizard—Select a Source File 

2. Click the Select File button to select the file.  DTAS displays the Open dialog box.  Navigate 
to the folder location of the file you wish to upload.  Highlight the file and then click Open or 
double click on the file to select it.  DTAS displays the file name and path on the dialog and 
activates the Next button.  Click Next to proceed. 
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Figure 2–16:  Mass Attach Wizard—Source File Selected 

Note:  If the file you select is not of the appropriate type (either an XML, a TRN, or a CSV 
file), DTAS displays a message informing you that the file is not in the proper format.  Click 
OK to return to the Mass Attach Wizard dialog. 

 

 

Figure 2–17:  Mass Attach Wizard—File Error Message 

 
Note:  When adding personnel from a CSV file, the Mass Attach Wizard will not load 
records that are missing data or contain errors.  The Mass Attach Wizard will only load 
complete/accurate records; any records containing errors will not be loaded.  You will be 
unable to load information for these persons until you correct the errors.  If your CSV file 
contains errors, the system displays an error message (shown below) informing you that the 
file contains errors as well as the location of the error log file.   
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Figure 2–18:  Mass Attach Wizard—CSV File Error Message 

 
The error log file provides information on what values are missing and in which record 
(corresponds to the rows of the spreadsheet).  To correct the CSV file:  From the Tools menu, 
select CSV File and then Edit (see Section 2.2.5, CSV File, for additional information).  
 

 

Figure 2–19:  CSV File Error Log 

3. DTAS displays the Select People to Load dialog box.   
4. By default, all records are selected.  Click Select All to select all records or you can select 

individual records by clicking the check box to the left of each record to select individual 
records you wish to load.  You can also click Deselect All to deselect all the records or you 
can deselect individual records by clicking the checkbox to the left of the record.   
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Figure 2–20:  Mass Attach Wizard—Select People to Load 

5. Click Next to proceed.  The application displays the Select Arrival Date/Time and Operation 
data (or if adding personnel from a CSV file, the Select Operation Data) dialog.   

 

 

Figure 2–21:  Select Arrival Date/Time and Operation Data Dialog 
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Figure 2–22:  Select Operation Data Dialog 

6. Select the name of the operation to which the personnel are being added from the Operation 
picklist.  This is a required field. 

7. The Arrival Date/Time picklist defaults to what has previously been entered for the arrival 
date and time (the Arrival Date/Time field is not displayed for CSV files).  If you enter an 
Arrival Date/Time that is 30 or more days old, DTAS enables the Re-enter Arrival 
Date/Time field and you must re-enter the arrival date and time.  Note:  The arrival date and 
time cannot be a date greater than 4 years old. 
 
For CSV files, if the Arrival Date/Time in the file is not a valid arrival date and time, the 
Arrival Date/Time field defaults to the current system date and time. 

8. Click Next to proceed with the load process.  DTAS displays the Physical Location dialog.   
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Figure 2–23:  Mass Attach Wizard—Select Physical Location (XML and TRN Files) 

 

 

Figure 2–24:  Mass Attach Wizard—Select Physical Location (CSV Files) 

9. In the Physical section, select the type of location from the Type picklist.   
10. Select a location from the Location picklist.   
11. You may edit the Grid Zone Designator (this three alphanumeric characters with the first two 

characters numerals and the last an alphabetic character), the Grid Square Identifier (this is 
two letters) and the Grid Zone Coordinates (this must consist of six or eight numbers).   

12. For XML and TRN files, DTAS defaults the Date/Time field to the date and time previously 
entered, and displays it as read-only. 
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13. Click Finish to load the data into the database.   
14. Click Back to return to the previous step in the process. 
15. Click Cancel to exit the process without adding data. 

2.3.3 System Info 

The System Info function provides you with contact and activation date information related to 
your DTAS system.  To view information related to your system, perform the following steps:  
Select System Info from the Tools menu.  DTAS displays the System Info dialog box.  Click 
Close when you are finished.  DTAS closes the dialog box and returns you to your previous 
screen location.  
 

 

Figure 2–25:  System Info Dialog 

2.3.4 Deactivate System 

The Deactivate System functions allows you to reset your system.  The function removes the 
existing database.  To deactivate a system, select Deactivate System from the Tools menu.  
DTAS displays the Deactivate System confirmation message.  Click OK to proceed with the 
process.  Note:  This will remove the existing database, deleting all your data.  Click Cancel to 
cancel the deactivation without making any changes. 
 

 

Figure 2–26:  Deactivate System Message 
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2.3.5 View Synchronization Info 

The View Synchronization Info function allows you to view system-generated messages 
awaiting upload to the Theater system and a synchronization log that details the synchronizations 
sent between the Mobile and Theater systems.  To view synchronization information, select 
View Synchronization Info from the Tools menu.  DTAS displays the Synchronization Info 
window.  The window contains two tabs, Message Queue and Synchronization Log.  DTAS 
defaults the display to the Message Queue.  To change the display, click the Synchronization 
Log tab, and DTAS displays the log.  The information displayed is read-only.  Click Refresh to 
update the display to show the most recent data.  In addition, on the Synchronization Log tab you 
can specify how many rows are displayed in the window by selecting from the Row Height 
picklist.  When you are finished viewing the information, click Close.  DTAS returns you to your 
previous screen location. 
 

 

Figure 2–27:  Message Queue 
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Figure 2–28:  Synchronization Log 

2.3.6 Comma Separated Values (CSV) File 

The CSV File function allows you to create or edit an Excel spreadsheet that can be used for data 
entry and upload to DTAS.  The Excel spreadsheet is saved in a comma delimited format (.CSV 
file) that you can use to upload data using the Mass Assign Wizard or Mass Attach Wizard 
functions.  The CSV File function consists of submenu with two options:  New and Edit.  An 
example of the file format is provided below.  Note:  Required fields are denoted by an asterisk. 
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Figure 2–29:  Left Portion of the CSV Template 

 

 

Figure 2–30:  Right Portion of the CSV Template 

For information on the business rules associated with the CSV File function, refer to Section 
2.2.5.3, Business Rules:  CSV File. 

2.3.6.1 NEW 

To create a new CSV file, perform the following steps: 
1. Select CSV File from the Tools menu and then select New from the submenu. 
2. DTAS launches the Excel CSV file template. 
3. Enter data directly into the spreadsheet cells.  Required fields are denoted with a red flag in 

the upper right corner of the column header, as shown in the close-up below.  If you hover 
the cursor over the red flag, additional information about the data column is provided. 
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Figure 2–31:  CSV File Pop-Up 

 
4. The following fields are available for data entry: 

 Carrier—This is the organization that provided transportation for the individual.   
 SSN (Social Security Number)—This is the individual’s Social Security number.  The 

field requires nine numeric characters. 
 Last Name—Data entry is not limited in Excel; however, the database field is limited to 

30 alpha characters. 
 First Name—Data entry is not limited in Excel; however, the database field is limited to 

30 alpha characters. 
 MI (Middle Initial)—Data entry is limited to one alpha character. 
 Sex—Enter M for male and F for female. 
 Service—This field corresponds to the People Type field in the DTAS database and 

denotes the organization with which the individual is associated.  Data entry is made 
through a picklist. 

 DOD Component—This field is for designating the branch of the Department of 
Defense for whom the soldier or DoD civilian works. Data entry is made through a 
picklist. 

 Service Component—This field is for designating whether the soldier is Active, 
Reserve, or Guard.  A fourth data entry option of Unknown is available to the user.  Data 
entry is made through a picklist. 

 Foreign Military Indicator—This is a yes/no indicator of whether the individual is with 
a foreign military or is a foreign national.  Selection is made through a picklist. 

 RUC (Reporting Unit Code)—The RUC is the Marine Corps code for the soldier's 
deployed unit.  This code is analogous to the DASUIC in DTAS.  The code consists of 
five alphanumeric characters. 

 ULN (Unit Line Number)—The ULN is a line item number that corresponds to the 
MOS.  Each unit has a table of organization that lists each soldier by unit line number. 

 MOS (Military Occupational Specialty)—This identifies the soldier’s MOS, which is a 
group of duty positions of close occupational or functional relationships that facilitate 
interchangeability among persons of various skill levels.  Data entry consists of three 
alphanumeric characters for the Army, and four numeric characters for the Marine Corps. 
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 Rank—This field indicates the soldier’s current rank.  The rank should be entered as an 
abbreviation, such as SSG for Staff Sergeant. 

 TRUC (Temporary RUC)—The TRUC is a temporary unit to which a Marine is 
attached; it is used for temporary duty assignments. 

 APOE (Air Port of Embarkation)—This is the part from which the individual last 
departed en route to theater. 

 APOD (Air Port of Debarkation)—This is the individual’s point of arrival in theater. 
 Depart Date—This is the date the individual departs the APOE.  Data entry must be 

numeric characters.  Data entry should be eight numeric characters, including four-digit 
year, two-digit month, and two-digit day. 

 Depart Time—This is the time the individual departs the APOE.  Data entry must be 
numeric characters.  Data entry should be six numeric characters, including two-digit 
hour, two-digit minutes, and two-digit seconds. 

 Arrive Date (YYYYMMDD)—This is the date the individual arrives at the unit.  DTAS 
defaults this to the system date.  Data entry should be eight numeric characters, including 
four-digit year, two-digit month, and two-digit day.  

 Arrive Time (hh:mm:ss)—This is the time the individual arrives at the unit.  DTAS 
defaults this to the system date.  Data entry should be six numeric characters, including 
two-digit hour, two-digit minutes, and two-digit seconds. 

 Birth Date (YYYYMMDD)—This is the individual’s date of birth.  Data entry must be 
eight numeric characters, including four-digit year, two-digit month, and two-digit day. 

 Duty Status—This is the current duty status for the individual.  DTAS defaults the status 
to PDY, Present for Duty, during the Mass Assign Wizard process. 

 Blood—Enter the individual’s blood type by selecting the code that corresponds to the 
blood type.  Selection is made from a picklist which includes the following options: 

– A denotes A+ blood type 
– B denotes A- blood type 
– C denotes B+ blood type 
– D denotes B- blood type 
– E denotes O+ blood type 
– F denotes O- blood type 
– G denotes AB+ blood type 
– H denotes AB- blood type 

 Marital Status—Enter the current marital status for the individual.  Selection is made 
from a picklist, which includes the following options: 

– A:  Annulled  
– D:  Divorced 
– I:  Interlocutory Decree 
– L:  Legally Separated 
– M:  Married 
– S:  Single 
– W:  Widowed 
– Z:  Unknown 
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5. The following fields have pull-down menus associated with them to expedite data entry: 
 Service 
 DoD Component 
 Service Component 
 Foreign Military Indicator 
 Blood 
 Marital Status 

6. After completing data entry, select Save from the File menu to save the file.  Excel displays a 
message prompting you to confirm that you would like to save the file.  You may perform 
one of the following:  
 Click Yes to save the file.  Note:  Ensure you save the file and that you maintain the file 

in CSV format.  If you do not click Yes to save your file, you will lose the data you have 
entered. 

 Click No to proceed without saving your changes.  
 Click Cancel to return to the spreadsheet and make further changes. 

 

 

Figure 2–32:  Save Prompt 

2.3.6.2 EDIT 

To edit an existing CSV file, perform the following steps: 
1. Select CSV File from the Tools menu and then select Edit from the submenu. 
2. DTAS displays the Open dialog box. 
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Figure 2–33:  Open Dialog 

3. Enter the changes you want and save the file.  Select Save from the File menu to save the 
file.  Excel displays a message prompting you to confirm that you would like to save the file.  
Click Yes to save the file.  Click No to proceed without saving your changes or click Cancel 
to return to the spreadsheet and make further changes. 

2.3.6.3 BUSINESS RULES:  CSV FILE 

The following business rules apply to the CSV File function: 
 If Other US Service Member or DoD Federal Civilian is selected, the DoD Component 

column must be populated. 
 If US Army Soldier or Other US Service Member is selected, the Service Component 

column must be populated. 
 If Foreign National/Military is selected, the Foreign Military Indicator must be populated. 
 If the person being added through the CSV file already exists on the local database, no 

add or update will be performed for that person. 
 If you enter data in an invalid format (for example, E1in the Rank field rather than the 

acronym), DTAS leaves that field null on the database.  This applies to all fields, except 
the following: SSN, Last Name, First Name, Sex, Service, DoD Component, Service 
Component, Foreign Military Indicator, and Duty Status. 

2.3.7 WorkFlow 

The WorkFlow function allows you to perform the following actions on WorkFlow notices:  
Acknowledge, Delete, or Mark as Read.  The WorkFlow functionality may be accessed through 
the WorkFlow… option on the Tools menu or by clicking the WorkFlow Inbox hyperlink, when 
enabled, on the People tab. 
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2.3.7.1 WORKFLOW INBOX 

The WorkFlow Inbox provides the ability to Acknowledge, Delete, or Mark as Read WorkFlow 
notices that have been received.  The action taken on a WorkFlow notice depends on the notice 
type.  WorkFlow notices can remain in the Inbox indefinitely until you take appropriate action.  
To take action on a WorkFlow notice, perform the following steps: 
1. From the Tools menu, select WorkFlow…. 
2. DTAS displays the WorkFlow dialog.  The Inbox tab is the default.   
3. Select one or more items in your Inbox to review.  You can select items individually or can 

select multiple items.  Alternately, you can select all the items by clicking the Select All 
button.  To deselect, all the selected items, click the Deselect All button. 

4. Select an action from the Action picklist.  Note:  The Acknowledge option is only enabled 
for Unit Attachment WorkFlow notices. 

5. Click OK.   
6. Click Close to close the WorkFlow window. 
 

 

Figure 2–34:  WorkFlow Inbox 

2.3.7.2 WORKFLOW OUTBOX 

The WorkFlow Outbox provides the ability to review and delete WorkFlow notices that have 
been sent.  WorkFlow notices can remain in the Outbox indefinitely until you delete them.  To 
delete a WorkFlow notice, perform the following steps: 
1. From the Tools menu, select WorkFlow…. 
2. DTAS displays the WorkFlow dialog.  The Inbox tab is the default.   
3. Click the Outbox tab to access your Outbox. 
4. Select one or more items to delete.  You can select items individually or can select multiple 

items.  Alternately, you can select all the items by clicking the Select All button.  To 
deselect, all the selected items, click the Deselect All button. 
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5. Click the Delete button to delete selected notices.   
6. Click Close to close the dialog. 
 

 

Figure 2–35:  WorkFlow Outbox 

2.3.8 WorkFlow Notice Types 

Currently, there are seven types of WorkFlow notices available to the Mobile user.  Each 
WorkFlow notice type serves a different purpose.  You may submit the following actions for 
WorkFlow notices: 

 Acknowledge—Note:  This action is only available for the Unit Attachment WorkFlow 
notice type.  If you Acknowledge the WorkFlow notice, it moves from the Inbox to the 
Outbox.  The WorkFlow notice acknowledging the unit attachment is sent to the Theater 
Manager during the next synchronization, but visibility of the WorkFlow notice is retained 
in the Outbox until you delete the notice. 

 Mark As Read—The status of the WorkFlow notice changes from Unread to Read. 
 Delete—The WorkFlow notice is deleted from the Inbox or Outbox. 

 
The following seven notice types are available on the Mobile system are as follows: 

 Individual Person Attachment—This notifies you when a unit has attached one of your 
assigned personnel. 

 Individual Person Attachment Delete—This notifies you when a unit has deleted an 
individual attachment of one of your assigned personnel. 

 Individual Person Attachment Release—This notifies you when a unit has released an 
individual attachment of one of your assigned personnel. 

 Invalid Individual Person Attachment—This notifies you that an invalid attachment 
was submitted by this Mobile system via the Attach Personnel or Mass Attach Wizard 
function.  The erroneously attached person was removed from your Mobile system 
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because the record does not exist on another Mobile system in this Theater.  You must 
contact the person’s assigned unit to get this person assigned to a Mobile system.  After 
the person has been assigned to a Mobile system, you may resubmit the Attach Personnel 
action. 

 Unit Person Attachment Delete—This notifies you when a unit has deleted a unit 
attachment of one of your assigned personnel. 

 Unit Person Attachment Release—This notifies you when a unit has released a unit 
attachment of one of your assigned personnel. 

 Unit Attachment—This notifies you when one or more units are attached to a unit on 
your Mobile system. 

2.3.9 Attachment Physical Location 

To update the physical location of persons who are part of a unit attachment, perform the 
following steps: 
1. Select Attachment Physical Location from the Tools menu.  Alternatively, you may also 

select Attachment Physical Location by clicking the enabled hyperlink in the Hyperlinked 
Functions area of the People tab (see Section 6.2.6, Hyperlinked Functions, for more 
information). 

2. DTAS displays the Unit Attachment Selection dialog.  Select a unit attachment to process 
from the Attachment picklist. 

 

 

Figure 2–36:  Unit Attachment Selection Dialog 

3. Click Update to proceed.   
4. Click Delete to permanently delete the Attachment Physical Location action.   
5. Click Cancel to cancel the action and return to the People tab. 
6. DTAS displays the Unit Attachment Action–People Selection dialog. 
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Figure 2–37:  Unit Attachment Action–People Selection Dialog 

7. Select a person or persons to update.  You may select all persons listed by clicking Select 
All.  To deselect all persons you have selected, click Deselect All.  If you would like to 
update the physical location for more than one person, check the Continue to Update 
Physical Location checkbox.  This allows you to add more than one person without having to 
return to the Unit Attachment Selection dialog. 
 
Note:  After a person’s physical location is updated, the person’s record is removed from the 
unit attachment listing of the Attachment Physical Location function. 

8. Select a location from the Location picklist.  The default is Physical Locations.   
9. Enter the Grid Zone Designator (this must be two numbers and one letter) in the data entry 

field.  This is a required field. 
10. Enter the Grid Square Identifier (this must be two letters) in the data entry field.  This is a 

required field. 
11. Enter the grid coordinates (this must consist of six or eight numbers) in the Grid Coordinates 

field.  This is a required field. 
12. Click OK to save your changes and change the physical location of the attached person.  

DTAS returns you to the Unit Attachment Selection dialog if there are additional unit 
attachments.   

13. Click Cancel to return to the Unit Attachment Selection dialog without saving your changes. 
14. Click Cancel at the Unit Attachment Selection dialog to return to the People tab. 
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2.3.10 Unit Release 

The Unit Release menu option is enabled when there are units that you can release from 
attachment.  The Theater Manager, using the Theater Manager application, releases a unit from 
attachment.  DTAS Theater Manager sends a notice to the Mobile system associated with that 
unit indicating that the unit has been released from attachment.  To process a unit release from 
attachment, perform the following steps: 
1.  Select Unit Release from the Tools menu.  Alternatively, you may also select Unit Release 

by clicking the enabled hyperlink in the Hyperlinked Functions area of the People tab (see 
Section 6.2.6, Hyperlinked Functions, for more information). 

2. DTAS displays the Unit Release from Attachment dialog.  Select an attachment to process 
from the Attachment picklist. 

 

 

Figure 2–38:  Unit Release from Attachment Dialog 

3. Enter the release date and time.  The Release Date/Time picklist defaults to the current 
system date and time.  You can manually enter the date and time in the picklist, or you can 
select the date from the pop-up calendar or you can highlight the components of the date and 
time to change those manually (for example, clicking on the 2007 in 20070223 allows you to 
enter the year).  This is a required field.  Note:  The release date and time cannot be a future 
date/time.  DTAS displays an error message informing you that the date and time cannot be 
in the future. 

 

 

Figure 2–39:  Unit Release from Attachment Error Message 

4. Click OK to process the unit release attachment.  Note:  For each released person who has a 
deployed duty status of Present for Duty, the Unit Release action also updates the person’s 
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duty status to In-Transit – Local Reassignment.  Upon the return of the person to the assigned 
unit, the Mobile System manager of the assigned unit must update the person’s deployed 
duty status to Present for Duty. 

5. Click Cancel to return to the People tab without processing the unit release from attachment. 

2.4 Help Menu 

The Help menu contains the following options:  About; Contents, Index, and Search for the help; 
and Email Theater Manager.  The About function provides information about the DTAS 
application, such as the version number.  You can access help by either browsing the Contents or 
Index, or you can search the help file.  The Email Theater Manager allows you to email the 
Theater Manager if you have issues with your system; when you select the option, DTAS 
launches a blank email using your default email application. 
 

 

Figure 2–40:  Help Menu 
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3. ATTACHMENTS 

There are two types of attachments available to the user in DTAS, Individual Attachments and 
Unit Attachments.  The purpose for both is to provide the ability to view and update the DTAS 
record to the attached unit without removing certain update capabilities from the assigned unit.  
Although both the Individual Attachment and the Unit Attachment have the same purpose, each 
is implemented in DTAS differently. 
 
Note:  Do not use attachments to account for a person who is reassigned to your unit.  Instead, 
use the Assign Personnel function to add this person to your database. 
 
Please refer to Section 3.2, Assigned and Attached Unit Update Restrictions, for more 
information. 

3.1.1 Individual Attachment 

Use the Attach Personnel function if the person is supposed to be attached to your unit as an 
individual attachment.  (See Section 6.4,  Attach Personnel, for more information on initiating an 
Individual Attachment.)  If the person is supposed to be attached to your unit as part of a unit 
attachment, contact the Theater Manager to coordinate the unit attachment action. 

3.1.2 Unit Attachment 

The DTAS Theater Manager, using the Theater Manager application, creates a unit attachment 
by attaching a unit or units to another unit.  Unit attachments are established by the Theater 
Manager.  Contact the Theater Manager to coordinate the unit attachment action.  The Theater 
Manager sends a WorkFlow notice and an Attachment Physical Location action to the Mobile 
system associated with that unit attachment indicating that the unit has been attached. 
 
All available personnel are included in the unit attachment.  If the physical location of the 
personnel of the attached units has changed, you can use the Attachment Physical Location 
function to update the physical location of each person as required.  The following is an 
overview of the Unit Attachment process: 

 Theater Manager submits the action that attaches the units to one of your units in a Unit 
Attachment. 

 Theater sends the attached personnel to your Mobile system. 
 Theater sends a WorkFlow message and an Attachment Physical Location action to your 

Mobile system.  Both appear as hyperlinks in the upper right-hand corner of the main 
People tab. 

 You may Acknowledge, Mark As Read, or Delete the WorkFlow notice. 
 You may Update or Delete the Attachment Physical Location action. 
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3.2 Assigned and Attached Unit Update Restrictions 

If a person is not attached, the Mobile systems with visibility of the person’s assigned unit have 
the capability to submit any applicable update in DTAS.  However, if a person is attached to 
another unit, there are update restrictions in DTAS that depend on the Mobile system’s 
relationship to the unit. 
 
Note:  These update restrictions for attached personnel do not apply when the attached personnel 
are participating in a unit attachment that includes the Mobile system’s UIC. 

3.2.1 Assigned Unit Update Restrictions 

If a person is attached and your Mobile system has visibility of the assigned unit only, you 
cannot submit the following updates for the attached person:  Terminate Deployment. 

3.2.2 Attached Unit Update Restrictions 

If a person is attached and your Mobile system has visibility of the attached unit only, you cannot 
submit the following updates for the attached person: 

 Change any of the following using the Update Personnel function:  Person Type, DoD 
Component, Military Service Component, or Initial Arrival Date/Time 

 Terminate Deployment using the Update Duty Status function 
 Correct DASUIC 
 Reassign Personnel 
 Update Tour Status 
 Delete Person 
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4. UNKNOWN LOCATION AND DATA MISMATCH LIST 

The Unknown Location and Data Mismatch List window informs you of action you must take 
when persons contained within your mobile database either have an unknown location for their 
Assigned Location or have a mismatch between their Person Type and their DoD Component.   
 
DTAS checks the database every 10 minutes for persons who meet these criteria and displays the 
SSNs of affected persons in list form on the Unknown Location and Data Mismatch List 
window, as shown in Figure 4–1, Unknown Location and Data Mismatch List Window.  If no 
persons exist in your mobile database who match the criteria, DTAS does not display the 
Unknown Location and Data Mismatch List window.  DTAS displays the person’s information 
on the Unknown Location and Data Mismatch List window until the information is corrected.  
Click Close to close the window and return to the People tab screen.  Note:  You must close this 
window before updating the information for the persons listed.  
 

 

Figure 4–1:  Unknown Location and Data Mismatch List Window 

 
For information and procedures related to an unknown location, please see Section 4.1, 
Unknown Location.  For information and procedures related to a Person Type/DoD Component 
data mismatch, please see Section 4.2, Data Mismatch. 

4.1 Unknown Location 

On the left side (shown in Figure 4–2, Unknown Location Close-Up) of the Unknown Location 
and Data Mismatch List window, DTAS displays the SSNs of the persons who have an unknown 
location as their Assigned Location.  To be flagged for an unknown location, the person must 
have an unknown country code in the database. 
 



DTAS Mobile Application User Manual CM No.  DTAS-MAUM0-033-20080114 

4–2 
January 14, 2008 Draft (Version 3.3) 

FOR OFFICIAL USE ONLY 

 

Figure 4–2:  Unknown Location Close-Up 

 
To correct the person’s location, perform the following steps: 
1. Highlight the SSN and press Ctrl+C to copy the SSN to the clipboard. 
2. Close the Unknown Location and Data Mismatch List window. 
3. Copy the SSN into the SSN lookup field.   
4. Highlight the person and click Update Location. 
5. DTAS defaults the Location picklist in the Assigned Location area to Select One. 
6. Select the applicable assigned location from the picklist. 
7. Click OK to save the changes.  If you do not correct the Assigned Location, DTAS displays a 

message notifying you that you must enter all required fields.  Note:  If you select Cancel 
without correcting the Assigned Location, DTAS continues to display the person on the 
Unknown Location and Data Mismatch List until you take corrective action. 

4.2 Data Mismatch 

On the right side (shown in Figure 4–3, Data Mismatch Close-Up) of the Unknown Location and 
Data Mismatch List window, DTAS displays the SSNs of the persons who have a mismatch 
between their Person Type and their DoD Component.  A person is flagged for a data mismatch 
if they meet the following criteria: 

 If the Person Type is US Army Soldier and the DoD Component is either null or a code 
other than Army 

 If the Person Type is United States Marine, US Air Force, US Coast Guard, or US Navy 
and the DoD Component code is either null, Army, or OSD 
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Figure 4–3:  Data Mismatch Close-Up 

 
To correct the person’s data mismatch, perform the following steps: 
1. Highlight the SSN and press Ctrl+C to copy the SSN to the clipboard. 
2. Close the Unknown Location and Data Mismatch List window. 
3. Copy the SSN into the SSN lookup field.   
4. Highlight the person and click Update Personnel. 
5. DTAS defaults the values on the screen to those stored in the database for the person.   
6. Select the applicable DoD Component from the picklist.  Alternatively, you may also change 

the Person Type by selecting the appropriate one from the picklist.  If you do not correct the 
Person Type or DoD Component code, DTAS displays a message informing you that the 
component selected does not match the Person Type selected. 

7. Click OK to save the changes.  Note:  If you select Cancel without correcting the DoD 
Component mismatch, DTAS continues to display the person on the Unknown Location and 
Data Mismatch List until you take corrective action. 
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5. DTAS FUNCTION TABS 

The DTAS application provides a streamlined interface from which you can quickly access the 
tasks you need to perform.  The interface presents information in a tab format (shown below), 
grouping functions and tasks according to the information they serve (that is People, Location, 
Reports, and Management tabs, which are discussed in Sections 6 through 9).  The default 
display is the People tab.  To access data on other tabs, click the tab and DTAS displays that tab 
in the foreground.  
 

 

Figure 5–1:  Close-Up of DTAS Tabs 
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6. PEOPLE TAB 

6.1 Overview 

The People tab displays the personnel in your UIC.  You may also update personnel data, tour 
status data, location data, and duty status from this tab.  The People tab provides the functionality 
to manage personnel records.  The tab displays the personnel assigned to your  UIC and their 
associated information.  The People tab provides the following functions: 

 Assign Personnel  
 Attach Personnel 
 Update Personnel 
 View Mini-Record 
 Release Personnel 
 Update Location 
 Update Tour Status 
 Reassign Personnel  
 Update Duty Status 
 Update Operation 
 Delete Person 
 Delete Attachment  
 Correct DASUIC 

 
For information about the components of the People tab and how to navigate the tab, refer to 
Section 6.2, Navigating the People Tab. 

6.2 Navigating the People Tab 

The People tab is divided into two panes:  the unit hierarchy and the display grid.  In addition, 
there are several search and information display areas on the tab, such as the Strength View, 
Search By, and Hyperlinked Functions areas.  The subsequent topics detail the various 
components of the People tab. 

 Unit Hierarchy 
 Display Grid 
 Strength View 
 Search By 
 Hyperlinked Functions 
 Displayed/Total 

 
The number of people displayed on the People tab can be changed through the selection of a unit 
in the unit hierarchy, checking Include Sub Units checkbox, or selecting the radio buttons in the 
Strength View area.  You can choose to display as many or a few people as needed.  The default 
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display is of the people assigned and attached to the unit displayed at the top of the Mobile 
system’s hierarchy tree.  For example, to display all people in the Mobile system’s database, 
select the unit displayed at the top of the hierarchy tree and check the Include Sub Units 
checkbox. 
 
The following topics detail how to change how people are displayed on the People tab. 

 Include Sub Units 
 Strength View 
 Display Grid 

6.2.1 Unit Hierarchy 

The left side of the People tab screen displays the unit hierarchy for this Mobile system.  The 
units are displayed in a tree format. 
 
The Unit Hierarchy provides a visual indication of which units are assigned to this Mobile 
system, which are attached to this Mobile system, and which are assigned to this Mobile but 
attached elsewhere.     
 

Relationship to Mobile Sample Visual Cue Used 

Assigned Unit (Not Attached 
Elsewhere) 

 The text is a plain font. 

Assigned Unit (Attached 
Elsewhere) 

 The text is a bold font. 

Attached Unit   The text is italicized and 
shaded. 

6.2.1.1 EXPANDING THE HIERARCHY 

Click the plus sign to display the organization below a unit that has subordinate units.  You can 
repeat this as needed to get to the level of detail desired.  Clicking the minus sign will collapse 
the level of the hierarchy selected, or you may collapse the entire hierarchy by clicking the minus 
sign for the unit at the top of the unit hierarchy tree. 
 

   

Figure 6–1:  Unexpanded Tree 

 

 

Figure 6–2:  Expanded Tree 
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6.2.1.2 SUBORDINATE UNITS 

Units within the unit hierarchy are displayed in a tree format.  A plus sign to the left of a unit’s 
name indicates that it has at least one subordinate unit.  A unit subordinate to another unit may 
have its own subordinate units.  In the example, units PK00A, PK00M, WAB8S1, and WAP2A0 
are subordinate units to TESTCE.  Unit WAP2A0 has one subordinate unit, WAB8HD.  In turn, 
WAB8HD has a subordinate unit, WABAAB. 
 

 

Figure 6–3:  Hierarchy Showing Multiple Subordinate Units 

6.2.1.3 SELECTING A UNIT 

To select a unit, click on the unit in the hierarchy.  The Mobile system displays the persons 
assigned and attached to the selected unit and any subordinate units.  Selecting a unit changes the 
people displayed on the right side of the screen. 

6.2.2 Include Sub Units 

Clicking the Include Sub Units checkbox displays all personnel within the unit you have selected 
and any subordinate unit of the selected unit.  If this checkbox is not checked, DTAS displays 
only those persons in the top branch or those persons of the unit you selected. 

6.2.3 Display Grid 

The right side of the screen displays the people for the selected unit and its subordinate units and 
their associated data.  The persons displayed in the table vary depending on several factors, such 
as whether you selected Include Sub Units, selected a unit within the hierarchy, or selected one 
of the Strength view radio buttons.   
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Figure 6–4:  Display Grid 

To perform a function, click on the button associated with the function you wish to perform.  
(Alternately, you can right click from within the display grid to access a pop-up menu—shown in 
Figure 6–5—of available functions.)  Depending on the function selected, DTAS then displays a 
selection window with a list of qualified personnel from which you can select a person for whom 
to perform the action.  The following functions pre-qualify a list of personnel available for 
selection: 

 Release Personnel 
 Update Location 
 Update Tour Status  
 Reassign Personnel 
 Update Duty Status 
 Update Operation 
 Delete Person 
 Delete Attachment 
 Correct DASUIC 
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Figure 6–5:  Right-Click Menu 

6.2.3.1 DISPLAY GRID COLUMN DEFINITIONS 

The display grid on the People tab displays the following data in columnar format: 
 Last Name—This is the last name of the person. 
 First Name—This is the first name of the person. 
 SSN—This is the person’s Social Security number. 
 DASUIC—The Deployed Assigned Unit Identification Code (DASUIC) is unit 

identification code (UIC) for the unit to which the person is assigned.   
 DATUIC—The Deployed Attached Unit Identification Code (DATUIC) is the UIC for 

the unit to which the person is attached as either an individual or unit attachment. 
 PUIC—The Parent Unit Identification Code is the assigned parent unit. 
 Rank—This is the person’s rank, if applicable. 
 Duty Status—This column lists the person’s duty status. 
 Reason—If applicable, this column displays the reason associated with the duty status. 
 Assigned Location—This the location of the person’s assigned unit. 
 MOS or PMOS—This column is either MOS for the Army view or PMOS for the 

Marine view. 
– MOS (Army)—This is the code for the person’s Military Occupational Specialty.  
– PMOS (Marine Corps)—This is the code for the person’s Primary Military 

Occupational Specialty. 
 Mini Rec—This column lists the status code (such as D for downloaded) for the Mini 

Record. 
 Person Type—This is the Person Type of the individual.  Person Types can be one of the 

following:  DOD Contractor, DOD Federal Civilian, Foreign National/Military, NAF 
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Employee(AAFES), Non-DOD Federal Civilian, Other Civilian, Red Cross Worker, or 
United States Marine, US Air Force, US Army Soldier, US Coast Guard, or US Navy. 

6.2.3.2 DASUIC and DATUIC Overview 

The Deployed Assigned Unit Identification Code (DASUIC) is the unit to which the deployed 
person is assigned.  The DASUIC for the person does not change if they are attached to another 
unit—either through an individual or unit attachment. 
 
The Deployed Attached Unit Identification Code (DATUIC) is the unit to which the deployed 
person is attached.  The unit displayed in the DATUIC column will vary depending on the 
following factors: 

 If the person is part of a unit attachment, the DATUIC displayed is that of the attached 
unit. 

 If the person is part of an individual attachment, the DATUIC displayed is that of the unit 
to which the person is attached. 

 If the person is part of both an individual and a unit attachment, the DATUIC displayed is 
that of the unit associated with the person’s individual attachment. 

6.2.4 Strength View 

The Strength View area displays the count of Unit Strength, Available Strength, and Non 
Available personnel for the selected unit and its subordinate units.  Selecting the radio button for 
each option displays the associated people.  For example, selecting the Available Strength radio 
button displays those people who are assigned or attached to the unit you selected in the 
hierarchy (for additional information on the hierarchy, see Section 6.2.1, Unit Hierarchy) and 
who have an available duty status (either Present for Duty or Temporary Duty). 
 

 

Figure 6–6:  Strength View Area 

6.2.4.1 UNIT STRENGTH 

Unit Strength reflects the number of personnel assigned—including those attached elsewhere—
and attached to the selected unit.  The Unit Strength count includes all available and non-
available personnel.  Selecting the Unit Strength radio button changes the people displayed on 
the People tab; it displays all people either assigned or attached to the selected unit and its 
subordinates. 
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Figure 6–7:  Unit Strength Selection 

6.2.4.2 AVAILABLE STRENGTH 

The Available Strength count reflects the number of people listed under Unit Strength minus 
those persons who are non-available personnel.  The Available Strength count includes people 
with a duty status of Present for Duty and Temporary Duty.  Selecting the Available Strength 
radio button displays people in the selected unit and its subordinates who have an available duty 
status. 
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Figure 6–8:  Available Strength Selection 

6.2.4.3 NON AVAILABLE 

The Non Available count reflects all personnel attached from the selected unit and its 
subordinate units.  The count also reflects personnel assigned or attached in who have the 
following duty statuses:   

 Confined by Military Authorities 
 Convalescent Leave 
 Death Other 
 Duty Status Where Abouts Unknown 
 Hospitalized—Non Battle Incurred 
 Hospitalized—Battle Incurred 
 Killed in Action 
 Missing 
 Redeployed 
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 Rest and Recuperation 
 In Transit 
 Wounded in Action 

Selecting the Non Available radio button displays only those people who are attached elsewhere 
or who have a non-available duty status for the selected unit and its subordinate units. 
 

 

Figure 6–9:  Non Available Selection 

6.2.5 Search By 

The Search By fields allow you to search the listed data by SSN and Last Name.  To search by 
SSN, enter the soldier’s SSN or a partial SSN in the SSN field.  DTAS displays the soldier’s 
information or, in the case of a partial SSN, a list of SSNs that match the search criteria, as 
shown below.  To search by the soldier’s last name, enter the name or part of the name in the 
Last Name field.  DTAS displays only that soldier’s information if the full name was entered or 
displays those names that match the criteria entered.  To return to a full listing display, you must 
clear the SSN and Last Name data-entry fields. 
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Figure 6–10:  Search By Area 

6.2.6 Hyperlinked Functions 

The following functions are available as hyperlinks:  WorkFlow Inbox, Attachment Physical 
Location, and Unit Release.  Each function displays the number of items available for action.  
The hyperlink for each function is only enabled when there are items available for action. 
 

 

Figure 6–11:  Hyperlinked Functions 

6.2.7 Displayed/Total 

This area of the People tab lists the number of records displayed in the grid in the Displayed 
field.  The total number of records on the Mobile database is listed in the Total field. 
 

 

Figure 6–12:  Displayed/Total Area 

6.3 Assign Personnel 

The Assign Personnel function allows you to add personnel as they are assigned to your UIC.  
This function is set up using a wizard process that will guide you through the steps needed to 
assign personnel.  To add an individual, perform the following steps: 
1. Click Assign Personnel.  DTAS displays the Assign Personnel dialog box.  If you would like 

to add more than one person, check the Continue to Assign People checkbox.  This will allow 
you to add more than one person without having to return to the People tab. 
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Figure 6–13:  Assign Personnel Dialog (Army View) 
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Figure 6–14:  Assign Personnel Dialog (Marine View) 

2. Select the type of person you wish to add from the Person Type picklist.  DTAS defaults the 
picklist to US Army Soldier if the Army view was selected and defaults to United States 
Marine if the Marine view was selected.  The options are DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal Civilian, 
Other Civilian, Red Cross Worker, United States Marine, US Air Force, US Army Soldier, 
US Coast Guard, or US Navy.  The fields available for data entry will vary depending on the 
type of person selected.  Note:  Required fields are marked with an asterisk.   

3. You may change the arrival date and time if the person’s arrival date and time differs from 
the default of the system date.  If you enter a date 30 days or more in the past, DTAS enables 
the Re-enter Arrival Date/Time field to confirm the new arrival date and time.  The date you 
enter may not exceed 4 years in the past. 

4. Enter the required information using the provided text-entry fields and picklists.  Click Next 
to continue with the process.  DTAS displays a second Assign Personnel dialog.  Click 
Cancel to cancel the process without saving any data. 
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Figure 6–15:  Assign Personnel—Duty Status and Location Dialog (Army View) 

 

 

Figure 6–16:  Assign Personnel—Duty Status and Location Dialog (Marine View) 
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5. In the Duty Status section, select the duty status that applies to the individual from the Duty 
Status picklist.  The default is Present for Duty.  Depending on the duty status selected, you 
may need to select a reason from the Reason picklist.   

6. The date and time in the Date/Time field within the Duty Status, Assigned, and Physical, 
sections will be the date previously entered into DTAS; the field will be read-only in these 
data entry sections.  This field will be modifiable in the Tour Status section.  You may enter 
the date by either using the calendar function or manually typing the date.   

7. In the Assigned section, select a location from the Location picklist.  Note:  The location 
selected cannot be Unknown.  DTAS populates the Grid Zone Designator, Grid Square 
Identifier, and Grid Coordinates based on the location selected.  If the Assigned Location 
selected is not the same as the country for the person’s Operation location, the system 
displays a message informing you of the discrepancy.  Click OK to return to the Assign 
Personnel screen.   

 

 

Figure 6–17:  Assign Personnel—Associated Country Error Message 

8. In the Tour Status section, entry of the following information is mandatory: 
 The Tour Status picklist defaults to Temporary Change of Station.  Select a tour status 

from the picklist.   
 Select an appropriate value from the Tour Status Subtype picklist.  The values available 

in this picklist are filtered depending on the Tour Status selection. 
 The Tour Status Start Date defaults to the date/time you entered on the first Assign 

Personnel screen.  The field is modifiable. 
 Enter the length of the tour in the Number of Days field.  Note:  The value entered must 

be at least 1 and cannot be zero. 
9. Enter the length of the tour in the Number of Days field.  Note:  The value entered must be at 

least 1 and cannot be zero. 
10. In the Physical section, select the type of location from the Type picklist.   
11. Select a location from the Location picklist.  DTAS defaults this to the Assigned location you 

selected in the Assigned data entry area.  The Assigned and Physical locations can be 
different.   

12. You may edit the Grid Zone Designator (this must be two numbers and one letter), the Grid 
Square Identifier (this must be two letters), and the Grid Coordinates (this must consist of six 
or eight numbers).  These fields are populated with the data for the Assigned location value if 
the Assigned and Physical locations are the same.  If the Assigned and Physical location 
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differ, DTAS populates the Grid Zone Designator, Grid Square Identifier, and Grid Zone 
Coordinates with the values associated with the Physical location. 

13. Click Finish to save the record.  DTAS returns you to the People tab.  If you checked the 
Continue to Assign People checkbox, DTAS returns you the first page of the Assign 
Personnel wizard.  When you have finished adding all the individuals you want, uncheck the 
Continue to Assign People checkbox.  DTAS returns you to the People tab. 

14. In addition, you may either click Back to return to the previous dialog or click Cancel to 
cancel the process without saving data. 

6.3.1 Assign Personnel Dialog Fields 

The Assign Personnel dialog contains the following fields: 

 Person Type—This defaults to US Army Soldier if the view selected is Army.  If the 
view selected was Marine, the field defaults to United States Marine. 

 SSN/GUID (Social Security Number/Global Unique Identifier)—When entering a 
Social Security number, you must enter a nine digit number or an alphanumeric character 
string for a Foreign National/Military person type. 

 Birth Date—This defaults to the current date.  You may enter the correct date by either 
using the calendar function or manually typing the date.   

 Sex—The default is Select One; choose either Male or Female from the picklist. 
 Last Name 
 First Name 
 Middle Name 
 DASUIC (Deployed Assigned UIC)—This is the UIC to which this individual is 

assigned.   
 Arrival Date/Time—This is the date and time at which the individual arrived to the unit.  

You may enter the correct date by either using the calendar function or manually typing 
the date.   

 Re-enter Arrival Date/Time—This field is enabled if you enter an arrival date and time 
that is 30 days or more in the past.  You will be required to re-enter the date and time to 
confirm that it is a valid entry.  Note:  You cannot enter a date that is more than 4 years 
in the past. 

 DoD Component—The defaults for this field are as follows: 
– To Army for the US Army Soldier Person Type 
– To Marine Corps for the United States Marine Person Type 
– To Air Force for the US Air Force Person Type 
– To Coast Guard for the US Coast Guard Person Type 
– To Navy for the US Navy Person Type 

 Military Service Component—This defaults to Regular. 
 MOS/AOC (Army view) or PMOS (Marine view)  
 Rank—This defaults to Select One. 
 Operation—This is a required field.  The available selections are managed and sent 

down from Theater Manager. 
 Pay Plan—This defaults to Select One. 
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 Series—This defaults to Select One. 
 Pay Grade—This defaults to Select One. 
 Employer—This defaults to Select One. 
 Foreign Country—This defaults to Select One. 

Note:  Some of these fields are disabled (grayed out) depending on the Person Type selected. 
 
The following fields are located on the second page of the Assign Personnel dialog: 

 Duty Status Section 
– Duty Status—The default is Present for Duty.  Depending on the duty status selected, 

you may need to select a reason from the Reason picklist.   
– Date/Time—The date and time in the Date/Time field within the Duty Status, 

Assigned, and Physical, sections will be the date previously entered into DTAS; the 
field will be read-only in these data entry sections.  This field will be modifiable in 
the Tour Status section.  You may enter the date by either using the calendar function 
or manually typing the date.   

 Assigned Section 
– Location—This defaults to Select One.  Note:  The location selected cannot be 

Unknown.   
– Date/Time—The date and time will be the date previously entered into DTAS; the 

field will be read-only.    
 Tour Status Section 

– Tour Status—This defaults to Temporary Change of Station.   
– Tour Status Subtype—The values available in this picklist are filtered depending on 

the Tour Status selection. 
– Tour Status Start Date—This defaults to the date/time you entered on the first Assign 

Personnel screen.  The field is modifiable. 
– Number of Days—This is the length of the tour.  Note:  The value entered must be at 

least 1 and cannot be zero. 
– Date/Time—The date and time in the Date/Time field within the Duty Status, 

Assigned, and Physical, sections will be the date previously entered into DTAS; the 
field will be read-only in these data entry sections.  This field will be modifiable in 
the Tour Status section.  You may enter the date by either using the calendar function 
or manually typing the date.   

 Physical Section 
– Type—This defaults to Specific.  This is a required field.   
– Location—DTAS defaults this to the Assigned location you selected in the Assigned 

data entry area.  The Assigned and Physical locations can be different.   
– Grid Zone Designator—This must be two numbers and one letter.  This is a required 

field.   
– Grid Square Identifier—This must be two letters.  This is a required field. 
– Grid Zone Coordinates—This must consist of six or eight numbers.  This is a required 

field. 
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– Date/Time—The date and time will be the date previously entered into DTAS; the 
field will be read-only.    

6.4 Attach Personnel 

The Attach Personnel function allows you to attach personnel as they arrive to your unit, if they 
meet the following criteria: 

 The person remains assigned to another unit in this deployed theater. 
 You must account for this person on your Mobile system. 

This function is set up using a wizard process that will guide you through the steps needed to 
attach personnel.  To attach an individual, perform the following steps: 
1. Click Attach Personnel.  DTAS displays the Attach Personnel dialog box.  If you would like 

to add more than one person, check the Continue to Attach People checkbox.  This will allow 
you to attach more than one person without having to return to the People tab. 

 

 

Figure 6–18:  Attach Personnel Dialog (Army View) 
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Figure 6–19:  Attach Personnel Dialog (Marine View) 

2. Select the type of person you wish to add from the Person Type picklist.  DTAS defaults the 
picklist to US Army Soldier if the Army view was selected and defaults to United States 
Marine if the Marine view was selected.  The options are DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal Civilian, 
Other Civilian, Red Cross Worker, United States Marine, US Air Force, US Army Soldier, 
US Coast Guard, or US Navy.  The fields available for data entry will vary depending on the 
type of person selected.  Note:  Required fields are marked with an asterisk.   

3. You may change the arrival date and time if the person’s arrival date and time differs from 
the default of the system date.  If you enter a date 30 days or more in the past, DTAS enables 
the Re-enter Arrival Date/Time field to confirm the new arrival date and time.  The date you 
enter may not exceed 4 years in the past. 

4. Enter the required information using the provided text-entry fields and picklists.  Click Next 
to continue with the process.  DTAS displays a second Attach Personnel dialog.  Click 
Cancel to cancel the process without saving any data. 
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Figure 6–20:  Attach Personnel—Duty Status and Location Dialog (Army View) 

 

 

Figure 6–21:  Attach Personnel—Duty Status and Location Dialog (Marine View) 
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5. In the Duty Status section, select the duty status that applies to the individual from the Duty 
Status picklist.  The default is Present for Duty.  Depending on the duty status selected, you 
may need to select a reason from the Reason picklist.   

6. The date and time in the Date/Time field within the Duty Status, Assigned, and Physical, 
sections will be the date previously entered into DTAS; the field will be read-only in these 
data entry sections.   

7. The Assigned section is not available for data entry for Attach Personnel.  
8. The Tour Status section is not available for data entry for Attach Personnel.  This information 

is sent from Theater Manager.  
9. In the Physical section, select the type of location from the Type picklist.  This is a required 

field. 
10. Select a location from the Location picklist.  DTAS defaults this to the Physical Locations.   
11. Enter the Grid Zone Designator (this must be two numbers and one letter), the Grid Square 

Identifier (this must be two letters), and the Grid Coordinates (this must consist of six or 
eight numbers).  These fields are required. 

12. Click Finish to save the record.  DTAS returns you to the People tab.  If you checked the 
Continue to Attach People checkbox, DTAS returns you the first page of the Attach 
Personnel wizard.  When you have finished attaching all the individuals you want, uncheck 
the Continue to Attach People checkbox.  DTAS returns you to the People tab. 

13. In addition, you may either click Back to return to the previous dialog or click Cancel to 
cancel the process without saving data. 

6.4.1 Attach Personnel Dialog Fields 

The Attach Personnel dialog contains the following fields: 

 Person Type—This defaults to US Army Soldier if the view selected is Army.  If the 
view selected was Marine, the field defaults to United States Marine. 

 SSN/GUID (Social Security Number/Global Unique Identifier)—When entering a 
Social Security number, you must enter a nine digit number or an alphanumeric character 
string for a Foreign National/Military person type. 

 Birth Date—This defaults to the current date.  You may enter the correct date by either 
using the calendar function or manually typing the date.   

 Sex—The default is Select One; choose either Male or Female from the picklist. 
 Last Name 
 First Name 
 Middle Name 
 Deployed Attached UIC—This is the UIC to which this individual is attached.  
 Arrival Date/Time—This is the date and time at which the individual arrived to the unit.  

You may enter the correct date by either using the calendar function or manually typing 
the date.   

 Re-enter Arrival Date/Time—This field is enabled if you enter an arrival date and time 
that is 30 days or more in the past.  You will be required to re-enter the date and time to 
confirm that it is a valid entry.  Note:  You cannot enter a date that is more than 4 years 
in the past. 
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 DoD Component—The defaults for this field are as follows: 
– To Army for the US Army Soldier Person Type 
– To Marine Corps for the United States Marine Person Type 
– To Air Force for the US Air Force Person Type 
– To Coast Guard for the US Coast Guard Person Type 
– To Navy for the US Navy Person Type 

 Military Service Component—This defaults to Regular. 
 MOS/AOC (Army view) or PMOS (Marine view)  
 Rank—This defaults to Select One. 
 Operation—This is a required field.  The available selections are managed and sent 

down from Theater Manager. 
 Pay Plan—This defaults to Select One. 
 Series—This defaults to Select One. 
 Pay Grade—This defaults to Select One. 
 Employer—This defaults to Select One. 
 Foreign Country—This defaults to Select One. 

Note:  Some of these fields are disabled (grayed out) depending on the Person Type selected. 
 
The following fields are located on the second page of the Attach Personnel dialog: 

 Duty Status Section 
– Duty Status—The default is Present for Duty.  Depending on the duty status selected, 

you may need to select a reason from the Reason picklist.   
– Date/Time—The date and time in the Date/Time field within the Duty Status, 

Assigned, and Physical, sections will be the date previously entered into DTAS; the 
field will be read-only in these data entry sections.   

 Assigned Section 
– The Assigned section is not available for data entry for Attach Personnel.  

 Tour Status Section 
– The Tour Status section is not available for data entry for Attach Personnel.  This 

information is sent from Theater Manager.  
 Physical Section 

– Type—This defaults to Specific.  This is a required field. 
– Location—DTAS defaults this to the Physical Locations.   
– Grid Zone Designator—This must be two numbers and one letter.  This is a required 

field.   
– Grid Square Identifier—This must be two letters.  This is a required field. 
– Grid Zone Coordinates—This must consist of six or eight numbers.  This is a required 

field. 
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6.4.2 Business Rules:  Attach Personnel 

The following business rules apply to the Attach Personnel function: 
 A person must be assigned in the deployed theater and exist on a Mobile system before 

the Attach Personnel function can be used successfully.  If you use the Attach Personnel 
function to attach a person who does not meet this requirement, the Theater system sends 
a message to delete the attached person’s record and a WorkFlow notice to alert you to 
the problem.  If this happens, contact the person’s assigned unit and inform them to use 
the Assign Personnel function to assign the person to a unit on their Mobile system.  
After the assigned unit submits the Assign Personnel action, you can use the Attach 
Personnel function to attach the person again. 

 The effective date/time of the attachment cannot be before the initial arrival date/time to 
the deployed theater.  If you back-date the attachment before the initial arrival date/time 
to theater, the Theater system sends a message to delete the attached person.  If this 
happens, contact the Theater Manager to determine the initial arrival date/time of the 
person.  Then you may use the Attach Personnel function, to attach the person again with 
an effective date/time that is after the initial arrival date/time to theater. 

6.5 Update Personnel 

The Update Personnel function allows you to change information on DTAS for a selected 
individual.  This function allows you to update the person’s DoD Component, gender, the 
spelling of his or her name, etc.  To update personnel information for an individual, perform the 
following steps: 
1. Highlight the name of the individual for whom you wish to update information.   
2. Click the Update Personnel button.  DTAS displays the Update Personnel dialog box.  Note:  

The title bar of the dialog box will display the function, Update Personnel, and the name of 
the person whose information you are updating. 
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Figure 6–22:  Update Personnel Dialog (Army View) 

 

 

Figure 6–23:  Update Personnel Dialog (Marine View) 
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3. Change the information that you need directly in each field.  For example, to change the 
person type, select from the Person Type picklist or to change the spelling of the last name, 
type in your correction.   

4. After you have completed your changes, click OK to save the changes.  DTAS returns you to 
the People tab screen.  Click Cancel to exit the transaction without saving any changes. 

Updating the Person Type, Initial Arrival Date, DoD Component, or Service Component fields 
generates a message to the Theater system to update the data.  If you update the Person Type, 
DoD Component, or Service Component fields, DTAS prevents data from being sent from the 
Theater system via the mini-record to overlay the data on the Mobile system. 

6.5.1 Enabled Fields for Update Personnel 

Some fields are unavailable for update depending on the Person Type selected.  The following 
lists the fields available for update by Person Type: 

 Foreign National/Military Person Type—The following business rules for Update 
Personnel apply to the Foreign National/Military Person Type: 
– The record retains the Mini Record Indicator of ―P‖ status; after adding the record to 

the system, the indicator does not change to ―U‖ or ―D‖.  
– The enabled fields on load are:  SSN/GUID, Birth Date, Sex, Last Name, First Name, 

Middle Name, Initial Arrival Date/Time, Foreign Country and Foreign Military.   
– Note:  The Person Type cannot be changed. 

 All Other Person Types With Mini Record Indicator of ―P‖ or ―U‖—The following 
business rules for Update Personnel apply to all Person Types with a Mini Record 
Indicator of ―P‖ or ―U‖—except Foreign National/Military: 
– All fields that are appropriate to the Person Type are enabled. 
– If Person Type is changed, then fields are enabled or disabled as needed.   
– Note:  The Foreign National/Military will not be a value in the Person Type pick list. 

 All Other Person Types With Mini Record Indicator of ―D‖—The following business 
rules for Update Personnel apply to all Person Types with a Mini Record Indicator of 
―D‖: 
– The Person Type, DoD Component, and Initial Arrival Date/Time fields are always 

enabled. 
– For all Military Person Types (Army, Marine, etc.), the Military Service Component 

is always enabled. 
– If the Person Type is changed, then the fields are enabled or disabled as needed.  This 

includes fields that had been previously disabled on the initial screen load.   
– Note:  Foreign National/Military is not listed as a value in the Person Type picklist. 
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6.6 View Mini-Record 

The View Mini-Record function provides an abbreviated personnel record for the selected 
individual.  For ease of use, the record is divided into five tabs:  Deployment, Basic, Service, 
Personal, and Patient Tracking.   
 
The data displayed in the mini-record is downloaded to the Mobile database from the Enterprise 
System, which receives the data from eMILPO and ODSE for Army and Marine Corps 
personnel, respectively.  If a person is not on either eMILPO or ODSE, then the data is obtained 
from DMDC.  Please contact the Theater Manager if these records do not download properly 
(remain in P status). 
 
To view the mini record, perform the following steps: 
1. Highlight the name of the person for whom you wish to review the record. 
2. Click the View Mini-Record button.  DTAS displays the DTAS Mini-Record Screen with the 

Deployment tab as the default view.   
3. To view another tab, click on that tab.   
4. Click Close to return to the People tab. 

6.6.1 Deployment Tab 

The Deployment tab displays information about an individual’s deployment, such as Deployed 
Operation Name, Tour Status information, and location information. 

6.6.1.1 LIMITED EXTERNAL DATA BLOCK FIELD 

The Limited External Data Block field displays a blocking indicator with three possible values: 
 X—Indicates that the mini-record has not been received from Enterprise.  The Limited 

External Data Block displays this value, after you use the Assign Personnel or Mass 
Assign Personnel function to add a non-existing person to your Mobile System. 

 N—Indicates that the mini-record has been received from Enterprise and that you will 
continue to accept values from the Enterprise external data source (when the mini-record 
is refreshed or updated) for the following fields:  DoD Service Component and Service 
Component. 

 Y—Indicates that the mini-record has been received from Enterprise and that you will not 
continue to accept values from the Enterprise external data source (when the mini-record 
is refreshed or updated) for the following fields:  DoD Service Component and Service 
Component. 

 
If you use the Update Personnel function to update one of the following fields, the Limited 
External Data Block value will change to Y: 

 Person Type 
 DoD Service Component 
 Service Component 

Further mini-record updates from the external data source at Enterprise will not override your 
changes for the DoD Service Component and Service Component fields. 
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Figure 6–24:  Deployment Tab (Army View) 

 

Figure 6–25:  Deployment Tab (Marine View) 
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6.6.2 Service Tab 

The Service tab displays military service-related information, including the service component, 
home UIC, and BASD. 

 

 

Figure 6–26:  Mini-Record—Service Tab (Army View) 

 

 

Figure 6–27:  Mini-Record—Service Tab (Marine View) 
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6.6.3 Basic Tab 

The Basic tab displays information, such as the individual’s name, Social Security Number, 
Rank, etc. 
 

 

Figure 6–28:  Mini-Record—Basic Tab (Army View) 

 

 

Figure 6–29:  Mini-Record—Basic Tab (Marine View) 
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6.6.4 Personal Tab 

The Personal tab displays information such as birth date, race, and blood type. 
 

 

Figure 6–30:  Mini-Record—Personal Tab (Army View) 

 

 

Figure 6–31:  Mini-Record—Personal Tab (Marine View) 
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6.6.5 Patient Tracking Tab 

The Patient Tracking tab allows you to view hospitalization and condition information for a 
selected person. 
 

 

Figure 6–32:  Mini-Record—Patient Tracking (Army View) 

 

 

Figure 6–33:  Mini-Record—Patient Tracking (Marine View) 
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6.7 Release Personnel 

The Release Personnel function allows you to release a person from an attachment.  You may 
release a person’s Individual Attachment or Unit Attachment.  If the person has both an 
individual and a unit attachment, both attachments are released.  To release a person from 
attachment, perform the following steps: 
1. Click Release Personnel from the People tab.   
2. DTAS displays the Select Personnel for Release Personnel dialog.   

 

 

Figure 6–34:  Select Personnel for Release Personnel Dialog 

3. You can search for a person to release from attachment by using the Search By fields.  You 
can search by last name or Social Security number.  To search by last name, enter a partial 
name and click Search.  To search by SSN, select either the Begin SSN or End SSN radio 
button to indicate whether the numbers you enter are the beginning or end of the person’s 
SSN.  Click Search.  DTAS takes you to the first row that matches your search criteria.  If the 
row displayed is not for the correct person, you can continue to search by clicking Search. 

4. Highlight the name of the individual you wish to release from attachment.  You can select all 
the individuals listed by clicking Select All; to deselect all individuals selected, click 
Deselect All.  Note:  You may select multiple individuals by clicking additional records.  In 
addition, you may select all records by pressing Ctrl+A.   

5. You can release persons from attachment individually or as a group if the release date/time 
are the same.  If you release a person individually and want to continue processing other 
individuals, check the Continue to Release People checkbox. 
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6. Click OK to release the selected person from attachment. 
7. DTAS displays the Release Personnel dialog. 
 

 

Figure 6–35:  Release Personnel Dialog 

8. Enter the release date and time.  The Release Date/Time picklist defaults to the current 
system date and time.  You can manually enter the date and time in the picklist, or you can 
select the date from the pop-up calendar or you can highlight the components of the date and 
time to change those manually (for example, clicking on the 2007 in 20070226 allows you to 
enter the year).  This is a required field. 

9. Click OK to save your changes and release the individual from attachment.  DTAS returns 
you the People tab.  Note:  If the released person has a deployed duty status of Present for 
Duty, the Release Personnel action also updates the person’s duty status to In-Transit – Local 
Reassignment.  Upon the return of the person to the assigned unit, the Mobile System 
manager of the assigned unit must update the person’s deployed duty status to Present for 
Duty. 

10. If you checked the Continue to Release People checkbox, DTAS returns you to the Release 
Personnel From Individual Attachment dialog.  When you have finished releasing all the 
individuals you want from attachment, uncheck the Continue to Release People checkbox.   

11. Click Cancel to return to the People tab without saving your changes. 

6.8 Update Location 

The Update Location function allows you to update the assigned and physical locations for a 
selected person.  To update the location for the selected individual, perform the following steps: 
1. Click Update Location from the People tab.   
2. DTAS displays the Select Personnel for Update Location dialog. 
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Figure 6–36:  Select Personnel for Update Location Dialog 

3. You can search for a person for whom to update the location by using the Search By fields.  
You can search by last name or Social Security number.  To search by last name, enter a 
partial name and click Search.  To search by SSN, select either the Begin SSN or End SSN 
radio button to indicate whether the numbers you enter are the beginning or end of the 
person’s SSN.  Click Search.  DTAS takes you to the first row that matches your search 
criteria.  If the row displayed is not for the correct person, you can continue to search by 
clicking Search. 

4. Highlight the name of the individual for whom you want to update the location.  You can 
select all the individuals listed by clicking Select All; to deselect all individuals selected, 
click Deselect All.   
 Note:  You may select multiple individuals by clicking additional records.  In addition, 

you may select all records by pressing Ctrl+A.   
 Note:  You cannot select multiple people if any of those individuals have a duty status of 

Convalescent Leave, Duty Status Where Abouts Unknown, Missing, Rest and 
Recuperation, or Redeployed. 

 Note:  If you select more than one person, then the Update Location form defaults the 
Location pick list to Select One for the Assigned location, to Specific for the Physical 
location, and to the current date and time for the Date/Time fields; the Grid Zone 
Designator, Grid Square Identifier, and Grid Coordinates fields are blank. 
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5. You can update location for people or as a group if the location is the same.  If you update 
the location for a person individually and want to continue processing other individuals, 
check the Continue to Update Location checkbox. 

6. DTAS displays the Update Location dialog. 
 

 

Figure 6–37:  Update Location Dialog 

7. Within the Assigned data entry section, select a location from the Location picklist.  DTAS 
populates the Grid Zone Designator, Grid Square Identifier, and Grid Coordinates fields 
based on the selected assigned location. 

8. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year). 

9. Within the Physical data entry section, you may select the location type from the Type 
picklist.   

10. Select a location from the Location picklist.  DTAS defaults this to the Assigned location you 
selected in the Assigned data entry area.  The Assigned and Physical locations can be 
different.   

11. You may edit the Grid Zone Designator (this must be two numbers and one letter), the Grid 
Square Identifier (this must be two letters), and the Grid Coordinates (this must consist of six 
or eight numbers).  These fields are populated with the data for the Assigned location value if 
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the Assigned and Physical locations are the same.  If the Assigned and Physical location 
differ, DTAS populates the Grid Square Identifier and Grid Zone Coordinates with the values 
associated with the Physical location. 

12. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year). 

13. Click OK to save the data.  DTAS returns you to the People tab.  Click Cancel to cancel the 
transaction without saving any data. 

6.9 Update Tour Status 

The Update Tour Status function allows you to update the Tour Status type, Tour Status subtype, 
date and time of the tour, and the length of the tour for a selected soldier or selected soldiers. 
 
To update the status of an individual, perform the following steps: 
1. Click Update Tour Status from the People tab.   
2. DTAS displays the Select Personnel for Update Tour Status dialog.   
 

 

Figure 6–38:  Select Personnel for Update Tour Status Dialog 

3. You can search for a person for whom to update the tour status by using the Search By fields.  
You can search by last name or Social Security number.  To search by last name, enter a 
partial name and click Search.  To search by SSN, select either the Begin SSN or End SSN 
radio button to indicate whether the numbers you enter are the beginning or end of the 
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person’s SSN.  Click Search.  DTAS takes you to the first row that matches your search 
criteria.  If the row displayed is not for the correct person, you can continue to search by 
clicking Search. 

4. Highlight the name of the individual for whom you want to update the tour status.  You can 
select all the individuals listed by clicking Select All; to deselect all individuals selected, 
click Deselect All.  Note:  You may select multiple individuals by clicking additional 
records.  In addition, you may select all records by pressing Ctrl+A.   

5. You can update tour status information for people or as a group if the status is the same.  If 
you update the tour status for a person individually and want to continue processing other 
individuals, check the Continue to Update Tour Status checkbox. 

6. Click OK.  DTAS displays the Update Tour Status dialog.  Note:  The title bar of the dialog 
box will show the name of the function, Update Tour Status, and the name of the individual 
whose record you are updating. 

 

 

Figure 6–39:  Update Tour Status Dialog 

7. Select a tour status from the Tour Status picklist.  The available options are Permanent Party, 
Temporary Change of Station, or Temporary Duty. 

8. Select a subtype from the Tour Status Subtype picklist.  The available options are filtered 
depending on the Tour Status selected.  Refer to Section 6.8.1, Tour Status/Tour Status 
Subtype Combinations, for a list of the subtypes available for the Tour Status selected. 

9. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year).  You 
can enter a date prior to the identified Theater Arrival Date/Time.  If you do so, DTAS 
displays a message (shown below) stating you have entered a date the precedes the Theater 
Arrival Date/Time and that the Date/Time may be changed to match the Theater Arrival 
Date/Time on the Enterprise system.  Note:  You cannot enter a Date/Time that is in the 
future. 
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Figure 6–40:  Update Tour Status Message 

Note:  The Update Tour Status message contains the Social Security number of the 
individual you are updating; however, it has been removed in this example for privacy 
reasons. 

10. Enter a value for the length of the tour in the Number of Days field.  Note:  The value must 
be a number greater than zero. 

11. Click OK to save your changes.  DTAS returns you to the display grid.  Click Cancel to exit 
the action without saving any changes. 

6.9.1 Tour Status/Tour Status Subtype Combinations 

The following Tour Status Subtypes are available when you select a Tour Status of Permanent 
Party: 

 Individual – Augmentee 
 Individual – Replacement 
 Unit – Active 

 
The following Tour Status Subtypes are available when you select a Tour Status of Temporary 
Change of Station: 

 Individual – Augmentee 
 Individual – Individual Ready Reserve (IRR) 
 Individual – Replacement 
 Individual – Retiree Recall 
 Unit – Active 
 Unit – Active Guard Reserve (AGR) 
 Unit – Individual Mobilized Augmentee (IMA) 
 Unit – Individual Ready Reserve (IRR)  
 Unit – Retiree Recall 
 Unit – Troop Program Unit (TPU) 

 
The following Tour Status Subtypes are available when you select a Tour Status of Temporary 
Duty: 

 Individual – Active Guard Reserve (AGR) 
 Individual – Augmentee 
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 Individual – Troop Program Unit (TPU) 
 Unit – Active 
 Unit – Active Guard Reserve (AGR) 
 Unit – Troop Program Unit (TPU)  

6.10 Reassign Personnel 

The Reassign Personnel function allows you to reassign a person to a new DASUIC.  To reassign 
a person, perform the following steps: 
1. Click Reassign Personnel from the People tab.   
2. DTAS displays the Select Personnel for Reassign Personnel dialog.   

 

 

Figure 6–41:  Select Personnel for Reassign Personnel Dialog 

3. You can search for a person to reassign by using the Search By fields.  You can search by 
last name or Social Security number.  To search by last name, enter a partial name and click 
Search.  To search by SSN, select either the Begin SSN or End SSN radio button to indicate 
whether the numbers you enter are the beginning or end of the person’s SSN.  Click Search.  
DTAS takes you to the first row that matches your search criteria.  If the row displayed is not 
for the correct person, you can continue to search by clicking Search. 

4. Highlight the name of the individual you wish to reassign.  You can select all the individuals 
listed by clicking Select All; to deselect all individuals selected, click Deselect All.  Note:  
You may select multiple individuals by clicking additional records.  In addition, you may 
select all records by pressing Ctrl+A.   
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5. You can reassign persons individually or as a group if the new DASUIC and the date/time 
are the same.  If you reassign a person individually and want to continue processing other 
individuals, check the Continue to Reassign Personnel checkbox. 

6. Click OK to reassign the selected person. 
7. DTAS displays the Reassign Personnel dialog. 
 

 

Figure 6–42:  Reassign Personnel Dialog 

8. Select the DASUIC from the Deployed Assign UIC picklist.  This is a required field. 
9. Enter the arrival date and time.  The Arrival Date/Time picklist defaults to the current system 

date and time.  You can manually enter the date and time in the picklist, or you can select the 
date from the pop-up calendar or you can highlight the components of the date and time to 
change those manually (for example, clicking on the 2007 in 20070226 allows you to enter 
the year).  This is a required field. 

10. Click OK to save your changes and reassign the individual.  DTAS returns you the People 
tab.   

11. If you checked the Continue to Reassign Personnel checkbox, DTAS returns you to the 
Select Personnel to Reassign Personnel dialog.  When you have finished reassigning all the 
individuals you want, uncheck the Continue to Reassign Personnel checkbox.   

12. Click Cancel to return to the People tab without saving your changes.   

6.11 Update Duty Status 

The Update Duty Status function allows you to change the duty status for the individual and to 
provide the reason and effective date for the change.  To update the duty status for an individual, 
perform the following steps: 
1. Click Update Duty Status from the People tab.   
2. DTAS displays the Select Personnel for Update Duty Status dialog.   
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Figure 6–43:  Select Personnel for Update Duty Status Dialog 

3. Select either the Update Duty Status or Terminate Deployment radio buttons depending on 
the action you want to perform.  The Terminate Deployment option is only used to change a 
person’s duty status to one of the following options:  Death Other, Killed in Action, 
Redeployed – Dropped From Rolls, Redeployed – Erroneously Added, Redeployed – 
Hospitalized (Nonbattle Incurred), Redeployed – Hospitalized (Battle Incurred), or 
Redeployed – Mission Complete. 

4. You can search for a person for whom to update the duty status by using the Search By 
fields.  You can search by last name or Social Security number.  To search by last name, 
enter a partial name and click Search.  To search by SSN, select either the Begin SSN or End 
SSN radio button to indicate whether the numbers you enter are the beginning or end of the 
person’s SSN.  Click Search.  DTAS takes you to the first row that matches your search 
criteria.  If the row displayed is not for the correct person, you can continue to search by 
clicking Search. 

5. Highlight the name of the individual for whom you want to update the duty status.  You can 
select all the individuals listed by clicking Select All; to deselect all individuals selected, 
click Deselect All.  Note:  You may select multiple individuals by clicking additional 
records.  In addition, you may select all records by pressing Ctrl+A.   

6. If you select more than one person, then the Update Deployed Duty Status form defaults the 
Duty Status picklist to Select One and the Date/Time field to the current date and time.  At 
the Location form, if you selected more than one individual, the defaults are as follows:   
 The Location picklist defaults to Select One for Assigned and Physical Locations for 

Physical.  
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 Both the Assigned and Physical Date/Time fields are the current date and time.   
 The Type picklist defaults to Specific.   
 The Grid Zone Designator, Grid Square Identifier and Grid Coordinates fields are blank 

and editable. 
7. You can update duty status information for people or as a group if the status is the same.  If 

you update the duty status for a person individually and want to continue processing other 
individuals, check the Continue to Update Duty Status checkbox. 

8. Click OK.  DTAS displays the Update Deployed Duty Status dialog.  Note:  The title bar of 
the dialog box will show the name of the function, Update Deployed Duty Status, and the 
name of the individual whose record you are updating. 

9. If the person you selected has previously been updated to one of the following duty statuses, 
you must first revoke the duty status before you can perform an update (see Section 6.11.1, 
Revoke Duty Status, for more information): 

– Redeployed-Mission Complete (RED-MIC) 
– Redeployed-Dropped from Rolls (RED-DFR) 
– Killed in Action (KIA) 
– DO (Death Other) 

 

 

Figure 6–44:  Update Duty Status Dialog 

10. Select the applicable status code from the Duty Status picklist.   
11. If required, select the reason for the status (for example, Emergency Leave) from the Reason 

picklist. 
12. Enter the date and time in the Date/Time picklist.  You can select the date from the pop-up 

calendar or you can highlight the components of the date and time to change those manually 
(for example, clicking on the 2004 in 20040511 allows you to enter the year). 

13. Click Next.  DTAS displays the Update Location dialog box.  Click Cancel to cancel the 
update without saving any changes.  Note:  If the selected Duty Status is In-Transit and the 
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selected Reason is Local Reassignment, the Next button changes to an OK button.  After you 
click OK, the Update Location dialog is not displayed.  DTAS processes the duty status 
update without an accompanying location update. 

 

 

Figure 6–45:  Update Duty Status—Location Dialog 

14. In the Assigned data entry area, select the individual’s assigned location from the Location 
picklist. 

15. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year). 

16. In the Physical data entry area, select the type from the Type picklist.   
17. Select a location from the Location picklist.  DTAS defaults this to the Assigned location you 

selected in the Assigned data entry area.  The Assigned and Physical locations can be 
different.   

18. You may edit the Grid Zone Designator (this must be two numbers and one letter), the Grid 
Square Identifier (this must be two letters), and the Grid Coordinates (this must consist of six 
or eight numbers).  These fields are populated with the data for the Assigned location value if 
the Assigned and Physical locations are the same.  If the Assigned and Physical location 
differ, DTAS populates the Grid Square Identifier and Grid Zone Coordinates with the values 
associated with the Physical location. 
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19. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2004 in 20040511 allows you to enter the year). 

20. Click OK to save the record.  Click Cancel to cancel the update without saving any changes. 

6.11.1 Revoke Duty Status 

The Update Duty Status function also provides you with the ability to revoke certain duty 
statuses.  The duty statuses for which you can perform a revocation are:  Killed in Action, Death 
Other, Redeployed-Mission Complete, and Redeployed-Drop From Rolls.  DTAS resets the duty 
status to Present for Duty with the current date and time.  To revoke a duty status for an 
individual, perform the following steps: 
1. Click the Update Duty Status button.  Note:  You may also right click the person’s record 

from the personnel list of the People tab and select Terminate Deployment. 
 

 

Figure 6–46:  Display Grid Showing Individual With Revocable Duty Status 

2. DTAS displays the Select Personnel for Update Duty Status dialog.  The Duty Status Options 
selection defaults to Update Duty Status.   
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Figure 6–47:  Select Personnel for Update Duty Status Dialog 

3. Select the Terminate Deployment option for the Duty Status Options selection.   
4. Highlight the row containing the individual with a revocable duty status (Killed in Action, 

Death Other, Redeployed – Mission Complete, or Redeployed – Drop From Rolls) for whom 
you wish to revoke the duty status. 

5. Click OK. 
6. DTAS displays the Update Deployed Duty Status dialog.  The Duty Status, Reason, and 

Date/Time fields are read-only.  
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Figure 6–48:  Update Deployed Duty Status Dialog—Revoke Duty Status 

7. Click Next to continue.  DTAS displays the Update Location dialog.  The Assigned Location 
and Physical Location default to data stored in DTAS for the individual.  If necessary, you 
can edit the Assigned Location and Physical Location information.   

 

 

Figure 6–49:  Update Location—Revoke Duty Status 
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8. In the Assigned data entry area, select the individual’s assigned location from the Location 
picklist. 

9. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2007 in 20070301 allows you to enter the year). 

10. In the Physical data entry area, select the type from the Type picklist.   
11. Select a location from the Location picklist.  DTAS defaults this to the Assigned location you 

selected in the Assigned data entry area.  The Assigned and Physical locations can be 
different.   

12. You may edit the Grid Zone Designator (this must be two numbers and one letter), the Grid 
Square Identifier (this must be two letters), and the Grid Coordinates (this must consist of six 
or eight numbers).  These fields are populated with the data for the Assigned location value if 
the Assigned and Physical locations are the same.  If the Assigned and Physical location 
differ, DTAS populates the Grid Square Identifier and Grid Zone Coordinates with the values 
associated with the Physical location. 

13. Select the date and time from the Date/Time picklist.  You can select the date from the pop-
up calendar or you can highlight the components of the date and time to change those 
manually (for example, clicking on the 2007 in 20070301 allows you to enter the year). 

14. Click OK to save the revocation.  Click Cancel to cancel the revocation and return to the 
People tab. 

6.11.2 Business Rules:  Update Duty Status Dialog 

6.11.2.1 GENERAL BUSINESS RULES 

The following business rules apply to the Update Duty Status dialog: 
 The following duty statuses do not require a reason: 

– Confined by Military Authorities 
– Convalescent Leave 
– Death Other 
– Duty Status Where Abouts Unknown 
– Hospitalized (Battle Incurred) 
– Hospitalized (Nonbattle Incur) 
– Killed in Action 
– Present for Duty 
– Temporary Duty 
– Wounded in Action 

 The following duty statuses require reasons (as listed): 
– In-Transit—Requires one of the following reasons:  Convalescent Leave, 

Emergency Leave, Local Reassignment, Mission Complete, Rest and Recuperation, 
and Temporary Duty 

– Missing—Requires one of the following reasons:  Absent Without Leave, 
Beleaguered, Besieged, Captured, Detained, Interned, Missing, and Missing in Action 

– Redeployed—Requires one of the following reasons:  Absent Without Leave; 
Convalescent Leave; Dropped From Rolls; Emergency Leave; Erroneously Added; 
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Hospitalized (Nonbattle Incur); Hospitalized (Battle Incurred); Mission Complete; 
Rest and Recuperation; and Temporary Duty. 

– Rest and Recuperation (R&R)—Requires you to select one of the following 
reasons:  Leave or Pass. 

 The Date/Time entered cannot be a future date or time. 
 When a Date/Time is entered that is prior to the current date/time, a history record is sent 

to the Theater and Enterprise systems, and the current status remains on the Mobile 
system. 

 When entering a Duty Status of When entering a Duty Status of Killed in Action, Death 
Other, Redeployed-Drop From Rolls, Redeployed-Erroneously Added, Redeployed-
Hospitalized (Nonbattle Incur), Redeployed-Hospitalized (Battle Incurred), or 
Redeployed-Mission Complete, the effective date entered must be more recent than the 
current Duty Status effective date. 

 A message is sent to the Theater system. 
 If you erroneously added a person to the mobile database, you may tag this person’s 

record for deletion using the Update Duty Status function.  Select a Duty Status of 
Redeployed and then select Erroneously Added to indicate the person was added 
incorrectly.  DTAS deletes the record after 24 hours. 

 No other DTAS update is allowed after a person has been updated to one of the following 
duty statuses.  These duty statuses must be revoked before another DTAS update is 
allowed.  Once a person has been updated to one of these duty statuses they will no 
longer appear in the Select Personnel for Update Duty Status dialog. 
– Redeployed-Mission Complete (RED-MIC) 
– Redeployed-Dropped from Rolls (RED-DFR) 
– Killed in Action (KIA) 
– DO (Death Other) 

6.11.2.2 SYSTEM MESSAGES 

DTAS generates several system messages depending on the duty status selected, as follows: 
 DTAS displays the following message with these duty statuses:  Death Other, Killed in 

Action, and Wounded in Action. 
 

 

Figure 6–50:  System Message—Casualty Status Warning 

 The Convalescent Leave duty status should only be used for in-theater convalescence.  
When you select this duty status, DTAS displays a message reminding you that this code 
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is for in-theater convalescent leave only and that you should use the Redeployed – 
Convalescent Leave for convalescence outside the theater. 

 

 

Figure 6–51:  System Message—Redeployed-Convalescent Leave 

 DTAS generates the message shown below if you select a duty status of Hospitalized 
(Battle Incurred). 

 

 

Figure 6–52:  System Message—Hospitalized (Battle Incurred) 

 DTAS generates the message shown below if you select a duty status of Rest and 
Recuperation (R&R). 

 

 

Figure 6–53:  System Message—Redeployed-Rest and Recuperation 

 DTAS generates the message shown below if you select a duty status of Temporary Duty. 
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Figure 6–54:  System Message—Redeployed-Temporary Duty 

 Selecting a duty status of Redeployed with a reason of Hospitalized (Battle Incurred) 
generates the following message: 

 

 

Figure 6–55:  System Message—Redeployed-Hospitalized (Battle Incurred) 

 Selecting a duty status of Redeployed with a reason of Dropped from Rolls generates the 
following error message if the 31-day threshold has not been met: 

 

 

Figure 6–56:  System Message—Redeployed-Dropped From Rolls 

 Selecting a duty status of Redeployed with a reason of Temporary Duty generates the 
following error message: 
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Figure 6–57:  System Message—Temporary Duty 

 Selecting a duty status of Redeployed with a reason of Erroneously Added generates the 
following error message: 

 

 

Figure 6–58:  System Message—Erroneously Added 

 Selecting a Duty Status of Killed in Action, Death Other, Redeployed-Drop From Rolls, 
Redeployed-Erroneously Added, Redeployed-Hospitalized (Nonbattle Incur), 
Redeployed-Hospitalized (Battle Incurred), or Redeployed-Mission Complete and 
entering a date later than the current Duty Status effective date generates the following 
message: 

 

 

Figure 6–59:  System Message—Cannot Enter Historical Data Message 

 If you try to update the duty status for a person who has previously been updated to one 
of the following duty statuses, DTAS displays notification on the Update Deployed Duty 
Status dialog informing you that you must first revoke the status (see the Revoke Duty 
Status topic for more information): 
– Redeployed-Mission Complete (RED-MIC) 
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– Redeployed-Dropped from Rolls (RED-DFR) 
– Killed in Action (KIA) 
– DO (Death Other) 

 

 

Figure 6–60:  Update Duty Status—Revoke Duty Status Message 

6.11.3 Business Rules:  Update Duty Status, Update Location Dialog 

 The Grid Zone Designator must be two numbers and one alphabetic character. 
 The Grid Square Identifier must be two letters. 
 The Grid Coordinates must be six or eight numbers. 
 The Assigned Date/Time cannot be a future date and time. 
 The Physical Date/Time cannot be a future date/time. 
 When a Date/Time is entered that is prior to the current date/time, a history record is sent 

to the Theater and Enterprise systems, and the current status remains on the Mobile 
system. 

 If you perform an update on multiple people (by using multi-select), the Assigned 
Location section can be left blank.  If an Assigned location is not entered, only the 
Physical location will be updated for each person selected. 

 The following duty statuses will have Unknown as the default Type in the Physical data 
entry area:  Missing (all reasons) and Duty Status Where Abouts Unknown. 

 The following duty statuses will have In-Theater as the Type selection in the Physical 
data entry area:  Convalescent Leave and Rest and Recuperation (R&R). 

 The following duty statuses will have Specific as the default Type in the Physical data 
entry area: 
– Confined by Military Authorities 
– Hospitalized (Battle Incurred)* 
– Hospitalized (Nonbattle Incur) 
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– In-Transit (with the following reasons:  Convalescent Leave, Emergency Leave, 
Mission Complete, Rest and Recuperation, and Temporary Duty) 

– Killed in Action 
– Present for Duty 
– Redeployed (Drop from Rolls) 
– Temporary Duty 
– Wounded in Action 

 
*Note:  The individual must first be in Wounded in Action status. 

 If you select In Transit with a reason of Local Reassignment, the Next button is an OK 
button.  Click OK and DTAS updates the status and returns you to the People tab. 

 The Physical location information for the Redeployed duty status varies by reason code, 
as follows: 
– The Absent Without Leave and Dropped from Rolls reason codes will have a location 

of Unknown. 
– The Convalescent Leave, Emergency Leave, Hospitalized (Nonbattle Incur), 

Hospitalized (Battle Incurred), Mission Complete, Rest and Recuperation, and 
Temporary Duty reason codes will have location selections of OCONUS and 
CONUS. 

 A message is sent to the Theater system. 

6.12 Update Operation 

The Update Operation function allows you to change the operation information for selected 
individuals.  To update operation information for a person, perform the following steps: 
1. Click Update Operation from the People tab.   
2. DTAS displays the Select Personnel for Update Operation dialog.   
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Figure 6–61:  Select Personnel for Update Operation Dialog 

3. You can search for a person for whom to update the operation by using the Search By fields.  
You can search by last name or Social Security number.  To search by last name, enter a 
partial name and click Search.  To search by SSN, select either the Begin SSN or End SSN 
radio button to indicate whether the numbers you enter are the beginning or end of the 
person’s SSN.  Click Search.  DTAS takes you to the first row that matches your search 
criteria.  If the row displayed is not for the correct person, you can continue to search by 
clicking Search. 

4. Highlight the name of the individual for whom you want to update the operation.  You can 
select all the individuals listed by clicking Select All; to deselect all individuals selected, 
click Deselect All.  Note:  You may select multiple individuals by clicking additional 
records.  In addition, you may select all records by pressing Ctrl+A.   

5. You can update operation information for people or as a group if the operation is the same.  
If you update the operation for a person individually and want to continue processing other 
individuals, check the Continue to Update Operation checkbox. 

6. DTAS displays the Update Operation dialog box.  Note:  The title bar of the dialog box will 
show the name of the function, Update Operation, and the name of the individual whose 
record you are updating. 
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Figure 6–62:  Update Operation Dialog 

7. The person’s current operation is displayed as read-only in the Current Operation field.  
Note:  If you selected more than on individual to update, the Current Operation field is not 
displayed. 

8. Select the new Operation from the New Operation picklist.  
9. Click OK to save the change.  DTAS returns you to the People tab screen.  Click Cancel to 

exit the action without saving any changes. 

6.13 Delete Person 

The Delete Person function allows you to delete a DTAS personnel record for a person who was 
incorrectly added to the system and whose record has not been sent to the Theater system.  The 
Delete Person function should not be used for an individual who is leaving the theater, who 
should be assigned a duty status of Redeployed–Mission Complete using the Update Duty Status 
function.  To delete the record for an individual, perform the following steps: 
1. Click Delete Person from the People tab.   
2. DTAS displays the Select Personnel for Delete Person dialog.   
 



DTAS Mobile Application User Manual CM No.  DTAS-MAUM0-033-20080114 

6–56 
January 14, 2008 Draft (Version 3.3) 

FOR OFFICIAL USE ONLY 

 

Figure 6–63:  Select Personnel for Delete Person Dialog 

3. You can search for a person to delete by using the Search By fields.  You can search by last 
name or Social Security number.  To search by last name, enter a partial name and click 
Search.  To search by SSN, select either the Begin SSN or End SSN radio button to indicate 
whether the numbers you enter are the beginning or end of the person’s SSN.  Click Search.  
DTAS takes you to the first row that matches your search criteria.  If the row displayed is not 
for the correct person, you can continue to search by clicking Search. 

4. Highlight the name of the individual you want to delete.  You can select all the individuals 
listed by clicking Select All; to deselect all individuals selected, click Deselect All.  Note:  
You may select multiple individuals by clicking additional records.  In addition, you may 
select all records by pressing Ctrl+A.   

5. If you delete a person and want to continue processing other individuals, check the Continue 
to Delete Person checkbox. 

6. Click OK.  DTAS displays the Delete Person confirmation.   
 

 

Figure 6–64:  Delete Person—Confirmation Message 
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7. Click OK to confirm the deletion.  DTAS deletes the latest deployment record for the person 
and returns you to the People tab screen. 

8. Click Cancel to cancel deletion of the record.  DTAS returns you to the Select Personnel for 
Delete Person dialog, and the record remains in the database. 

6.14 Delete Attachment 

The Delete Attachment function allows you to delete an attachment for an individual.  Only use 
the Delete Attachment function if the person was erroneously attached to your Mobile or one of 
its subordinate units.  You may remove a person’s Individual Attachment or Unit Attachment.  If 
the person has both an individual and a unit attachment, both attachments are deleted.  This 
function removes all history of the attachments from the Enterprise database.  To delete an 
attachment, perform the following steps: 
1. Click Delete Attachment from the People tab.   
2. DTAS displays the Select Personnel for Delete Attachment dialog.   
 

 

Figure 6–65:  Select Personnel for Delete Attachment Dialog 

3. You can search for a person for whom to delete an attachment by using the Search By fields.  
You can search by last name or Social Security number.  To search by last name, enter a 
partial name and click Search.  To search by SSN, select either the Begin SSN or End SSN 
radio button to indicate whether the numbers you enter are the beginning or end of the 
person’s SSN.  Click Search.  DTAS takes you to the first row that matches your search 
criteria.  If the row displayed is not for the correct person, you can continue to search by 
clicking Search. 
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4. Highlight the name of the individual for whom you want to delete an attachment.  You can 
select all the individuals listed by clicking Select All; to deselect all individuals selected, 
click Deselect All.  Note:  You may select multiple individuals by clicking additional 
records.  In addition, you may select all records by pressing Ctrl+A.   

5. You can delete an attachment for people individually or as a group.  If you delete the 
attachment for a person individually and want to continue processing other individuals, check 
the Continue to Delete Attachment checkbox. 

6. Click OK to delete the attachment for the person selected. 
7. DTAS displays the Delete Attachment confirmation message.   
 

 

Figure 6–66:  Delete Attachment—Confirmation Message 

8. Click OK to confirm the deletion.  DTAS deletes the record for the person and returns you to 
the People tab screen. 

9. Click Cancel to cancel deletion of the record.  DTAS returns you to the Select Personnel for 
Delete Attachment dialog, and the record remains in the database. 

6.15 Correct DASUIC 

The Correct DASUIC function allows you to change the DASUIC for a selected individual.  The 
Correct DASUIC function is used to correct an erroneously entered DASUIC.  The corrected 
DASUIC entered replaces the previous DASUIC in the database—the old DASUIC is not 
retained for historical purposes.   
 
Note:  The Correct DASUIC function is available only for those individuals for whom you have 
direct control.  (It is not available for those individuals one or more active levels below yours.) 
 
To correct the DASUIC for an individual, perform the following steps: 
1. Click Correct DASUIC from the People tab.   
2. DTAS displays the Select Personnel for Correct DASUIC dialog.   
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Figure 6–67:  Select Personnel for Correct DASUIC Dialog 

3. You can search for a person for whom to correct the DASUIC by using the Search By fields.  
You can search by last name or Social Security number.  To search by last name, enter a 
partial name and click Search.  To search by SSN, select either the Begin SSN or End SSN 
radio button to indicate whether the numbers you enter are the beginning or end of the 
person’s SSN.  Click Search.  DTAS takes you to the first row that matches your search 
criteria.  If the row displayed is not for the correct person, you can continue to search by 
clicking Search. 

4. Highlight the name of the individual for whom you want to correct the DASUIC.  You can 
select all the individuals listed by clicking Select All; to deselect all individuals selected, 
click Deselect All.  Note:  You may select multiple individuals by clicking additional 
records.  In addition, you may select all records by pressing Ctrl+A.   

5. You can correct the DASUIC for people individually or as a group if the DASUIC is the 
same.  If you correct the DASUIC for a person individually and want to continue processing 
other individuals, check the Continue to Correct DASUIC checkbox. 

6. DTAS displays the Correct DASUIC dialog box.  Note:  The title bar of the dialog box will 
show the name of the function, Correct DASUIC, and the name of the individual whose 
record you are updating. 
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Figure 6–68:  Correct DASUIC Dialog 

7. Select the new DASUIC from the New Deployed Assigned UIC picklist.  Note:  If you 
selected more than on individual to update, the Current Deployed Assigned UIC field is not 
displayed. 

8. Click OK to save the change.  DTAS returns you to the People tab screen.  Click Cancel to 
exit the action without saving any changes. 

 
 



DTAS Mobile Application User Manual CM No.  DTAS-MAUM0-033-20080114 

7–1 
January 14, 2008 Draft (Version 3.3) 

FOR OFFICIAL USE ONLY 

7. LOCATIONS TAB 

The Locations tab displays data related to locations within the deployment theater.  Locations are 
managed—including adding and editing locations—by the Theater Manager. 
 

 

Figure 7–1:  Locations Tab 
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8. REPORTS TAB 

The Reports tab displays the available reports that you may generate within the DTAS 
application.  The Reports function allows you to generate several reports to assist in tracking 
deployed personnel.  You can generate the following four reports:   

 Gains/Losses Report—The report displays those personnel who have either arrived at 
the unit or become a non-asset to the organization during the 24-hour reporting period.  
The report presents data from the 24-hour period preceding the time you generate the 
report.  The report consists of two parts—Gains and Losses—that are each presented on a 
separate worksheet in Microsoft Excel. 

 In Transit Report—This report displays data on those personnel who are in transit from 
the unit.   

 PERSTAT Report—This is the DTAS Personnel Status Report.  The report consists of 
four parts:  Personnel Daily Summary, Loss Summary, Gains Summary, and Remarks.  
The Remarks field is editable by the user; DTAS populates the other columns with data 
from the database.   

 Unit Roster—The Unit Roster lists all deployed personnel assigned to the unit for which 
you generate the report.   

 
DTAS displays all reports in Microsoft Excel.  You can only produce reports for the UICs for 
which you have visibility.  You have the capability to generate all available reports for your 
UICs.  You can manipulate the reports in Excel.  For directions on generating a report, refer to 
Section 8.1, Generating a Report. 
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Figure 8–1:  Reports Tab 

8.1 Generating a Report 

To generate a report, perform the following steps: 
1. Select a UIC from the Select UIC picklist. 
2. Check the Include Sub Unit checkbox if you would like to include personnel data from 

―child‖ UICs; otherwise, the report will include only personnel data related to the selected 
UIC.  

3. Click the radio button to the left of the report you wish to generate.  
4. If you selected the Unit Roster report, the Sort by picklist is activated.  Select a criterion by 

which you would like to sort the report data.  You can only select one criterion. 
5. Click View Report to generate the report.  DTAS displays the report in Microsoft Excel.   
6. You can print or save the report from within Excel.  To print the report, select Print from the 

File menu and click OK.  To save the report, select Save from the File menu, assign a file 
name, and click Save. 

8.2 Gains/Losses Report 

The Gains/Losses Report is divided into two worksheets:  one for gains and one for losses.  The 
Gains portion of the report lists personnel who have arrived in the current 24-hour reporting 
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period as a gain to the unit.  This is determined by the person’s arrival date and arrival time to 
the unit.  The Losses portion of the report lists those personnel who are no longer an asset to this 
organization.  These personnel became a non-asset during the current reporting period. 

8.2.1 Data Definitions (Army View) 

The following are the definitions for the data columns contained on both the Gains worksheet 
and the Losses worksheet of the Army report: 

 UIC—This is the unit identification code of the unit.   
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Name—This is the name of the individual gain or loss during this reporting period. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual gain or loss during this reporting period. 
 Person Type—This is the Person Type of the individual gain or loss during this reporting 

period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual gain or loss. 
 PMOS/AOC/Series—This is the primary MOS/AOC/Series of the individual gain or 

loss during this reporting period. 
 SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain or 

loss during this reporting period. 
 ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or loss 

during this reporting period. 
 2nd MOS—This is the secondary MOS of the individual gain or loss during this reporting 

period. 
 LANG—This is list of all language identifiers of the individual gain or loss during this 

reporting period. 
 Sex—This is the sex of the individual gain or loss during this reporting period. 
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 DDS—This is the deployed duty status of the individual gain or loss during this reporting 
period. 

 DDS Reason—This is the deployed duty status reason code of the individual gain or loss 
during this reporting period. 

 DDS Date—This is the deployed duty status date of the individual gain or loss during 
this reporting period. 

 Theater Arrival Date—This is the initial arrival date to the theater for the current 
deployment. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

8.2.2 Gains/Losses Report Sample (Army View) 

DTAS displays the Gains/Losses Report for the Army view in an Excel spreadsheet template as 
shown in the samples below. 
 

 

Figure 8–2:  Gains Worksheet (Army View) 
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Figure 8–3:  Losses Worksheet (Army View) 

8.2.3 Data Definitions (Marine View) 

The following are the definitions for the data columns contained on the both the Gains worksheet 
and the Losses worksheet of the Marine view report: 

 UIC—This is the unit identification code of the unit.   
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:  221805ZNOV04 
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Name—This is the name of the individual gain or loss during this reporting period. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual gain or loss during this reporting period. 
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 Person Type—This is the Person Type of the individual gain or loss during this reporting 
period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual gain or loss. 
 PMOS—This is the Primary Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 AMOS—This is the Alternate Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 1st AMOS—This is the First Alternate Military Occupational Specialty of the individual 

gain or loss during this reporting period. 
 LANG—This is list of all language identifiers of the individual gain or loss during this 

reporting period. 
 Sex—This is the sex of the individual gain or loss during this reporting period. 
 DDS—This is the deployed duty status of the individual gain or loss during this reporting 

period. 
 DDS Reason—This is the deployed duty status reason code of the individual gain or loss 

during this reporting period. 
 DDS Date—This is the deployed duty status date of the individual gain or loss during 

this reporting period. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 
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8.2.4 Gains/Losses Report Sample (Marine View) 

DTAS displays the Gains/Losses Report for the Marine view in an Excel spreadsheet template as 
shown in the samples below. 
 

 

Figure 8–4:  Gains Worksheet (Marine View) 
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Figure 8–5:  Losses Worksheet (Marine View) 

8.3 In Transit Report 

8.3.1 Data Definitions (Army View) 

The following are the definitions for the data columns contained on the In Transit report for the 
Army view: 

 UIC—This is the unit identification code of the unit.   
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Name—This is the name of the individual in transit. 
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 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 
the individual in transit. 

 Person Type—This is the Person Type of the individual gain or loss during this reporting 
period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual in transit. 
 MOS/AOC/Series—This is the MOS/AOC/Series of the individual in transit. 
 DDS—This is the deployed duty status of the individual in transit. 
 DDS Date—This is the deployed duty status date of the individual in transit. 
 DDS Reason—This is the deployed duty status reason code of the individual in transit. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment of the individual in transit. 
 Phys. Loc.—This is the physical location of the individual in transit. 
 Location Arrival Date—This is the arrival date to the current location of the individual 

in transit. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 
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8.3.2 In-Transit Report Sample (Army View) 

DTAS displays the In-Transit Report in an Excel spreadsheet template as shown in the Army 
view sample below. 
 

 

Figure 8–6:  In-Transit Report Sample (Army View) 

8.3.3 Data Definitions (Marine View) 

The following are the definitions for the data columns contained on the In Transit report for the 
Marine view: 

 UIC—This is the unit identification code of the unit.   
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 
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 Name—This is the name of the individual in transit. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual in transit. 
 Person Type—This is the Person Type of the individual gain or loss during this reporting 

period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual in transit. 
 PMOS—This is the Primary Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 DDS—This is the deployed duty status of the individual in transit. 
 DDS Date—This is the deployed duty status date of the individual in transit. 
 DDS Reason—This is the deployed duty status reason code of the individual in transit. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment of the individual in transit. 
 Individual Location—This is the location of the individual in transit. 
 Location Arrival Date—This is the arrival date to the current location of the individual 

in transit. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 
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8.3.4 In-Transit Report Sample (Marine View) 

DTAS displays the In-Transit Report in an Excel spreadsheet template as shown in the Marine 
view sample below. 
 

 

Figure 8–7:  In-Transit Report Sample (Marine View) 

8.4 PERSTAT Report 

The PERSTAT Report is divided into four parts: 
 Part I:  Personnel Daily Summary—The report provides a snapshot of personnel status 

for your unit, including gains and losses. 
 Part II:  Loss Summary—The Loss Summary report provides information on the 

aggregate number of losses and types of loss on one worksheet and provides a detailed 
loss report on a second worksheet. 

 Part III:  Gains Summary—The Gains Summary report provides information on the 
aggregate number of losses and types of loss on one worksheet and provides a detailed 
loss report on a second worksheet. 

 Part IV:  Remarks—The Remarks section allows you to include comments and 
additional information with the report. 
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There are several business rules that govern the data that are reported on the PERSTAT Report.  
Please refer to Business Rules:  PERSTAT Report for more information. 

8.4.1 Part I:  Personnel Daily Summary 

8.4.1.1 DATA DEFINITIONS 

The following are the definitions for the data columns contained on Part I of the PERSTAT 
report: 

 Report Number—This sequential number is generated by the unit for management for 
all PERSTAT reports. 

 DTG Prepared—Date Time Group prepared.  The DTG will be in the following format:  
221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 Person Type—The Person Type tracked includes Army–Regular Active, Army–Army 

Reserve, Army–National Guard, Army–Unknown, Navy, Air Force, Marines, Coast 
Guard, DoD Civilian, Non-DoD Civilian, Contractor, Other Civilian, NAF Employee 
(AAFES), Red Cross Worker, Foreign National Civilians, and Foreign National Military. 

 ASGD.—Assigned consists of all personnel assigned to the reporting unit. 
 ATCH—Attached consists of all personnel attached to the reporting unit. 
 Op. Strength—This is the operational strength number for the unit. 
 Females—This is a count of the number of female personnel in the unit. 
 KIA—This is a DTAS deployed duty status that represents a casualty who is killed 

outright or who dies as a result of wounds received in action. 
 WIA—This is a DTAS deployed duty status that represents a casualty who is wounded, 

sick, or injured as the result of a battle. 
 MIA—This is a DTAS deployed duty status that represents a Soldier who is missing in 

action by reason of enemy action. 
 Other Losses—This includes the following:   

– Confined by Military Authorities (CMA) 
– Convalescent Leave (CLV) 
– Death Other (DO) 
– Duty Status Where Abouts Unknown (DWU) 
– Hospitalized (Battle Incurred) (HOW) 
– Hospitalized (Nonbattle Incurred) (HOS) 
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– In-Transit (TRA) 
– Missing–Absent Without Leave (MIS-AWL) 
– Missing–Beleaguered (MIS-BGD) 
– Missing–Besieged (MIS-BSG) 
– Missing–Captured (MIS-CAP) 
– Missing–Detained (MIS-DTN) 
– Missing–Interned (MIS-INT) 
– Missing–Missing (MIS-MIS) 
– Redeployed (RED) 
– Rest and Recuperation (RNR) 
– The delete actions that originate from the Mobile and Theater systems. 
– The loss for the losing unit that results from an Correct DASUIC action. 
– The loss that results from an attachment that is ended or deleted. 

 Total Losses—This is the sum of the previous four columns on this report:  (1) KIA, (2) 
WIA, (3) MIA, and (4) Other Losses. 

 Gains—This includes personnel who have arrived in the current 24-hour reporting period 
as a gain to the unit.  This is determined by the person’s arrival date and arrival time to 
the unit. 

 Remarks—This block is an editable field, allowing you to manually type in relevant, 
useful data. 

8.4.1.2 PART I:  PERSONNEL DAILY SUMMARY SAMPLE (ARMY VIEW) 

A sample of the Personnel Daily Summary worksheet is shown below.  The sample shown is for 
the Army view. 
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Figure 8–8:  Part I:  Personnel Daily Summary Sample (Army View) 

8.4.1.3 PART I:  PERSONNEL DAILY SUMMARY SAMPLE (MARINE VIEW) 

A sample of the Personnel Daily Summary worksheet is shown below.  The sample shown is for 
the Marine view. 
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Figure 8–9:  Part I:  Personnel Daily Summary Sample (Marine View) 

8.4.2 Part II:  Loss Summary 

8.4.2.1 DATA DEFINITIONS FOR LOSS SUMMARY SECTION (ARMY VIEW) 

The following are the definitions for the data columns contained on the summary portion of Part 
II of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
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– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Person Type—The Person Type is derived from the following data elements:  DoD 
Contractor, DoD Federal Civilian, Foreign National/Military, NAF Employee (AAFES), 
Non-DoD Federal Civilian, Other Civilian, Other US Service Member, Red Cross 
Worker, or US Army Soldier. 

 PMOS/AOC/Series—This is the primary MOS/AOC/Series of the individual loss during 
this reporting period. 

 Grade/Skill Level—This represents the grade or skill level for the individual loss during 
this reporting period. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

 Loss Type—The Loss Type column of the Loss Summary page identifies the action or 
event that caused the person to become a loss.  The following is a listing of the possible 
loss types and their meanings: 
– DEL—This loss type is displayed when: 

 The person’s record is deleted.  The following events cause the deletion of a 
person’s record: 
– A Mobile system user submits the Delete Person action to delete a person’s 

record. 
– A reassignment action causes the Mobile system to lose visibility of the 

person’s record. 
 The person is reassigned.  If a Mobile system user submits an Correct DASUIC 

action for a person’s record, DEL is displayed as the loss type for the losing unit.   
– ATCH—This loss type is displayed for the following attachment-related losses: 

 Assigned unit.  When a person is attached out, ATCH is displayed as the loss 
type for the assigned unit. 

 Attached unit.  When a person’s attachment is released or deleted, ATCH is 
displayed as the loss type for the attached unit. 

– The loss type for duty status-related losses is the duty status itself.  For example, if a 
person’s duty status is changed to RNR, then the loss type will be RNR. 

 Total—This is the total number for each line of information 
 Remarks—This block is an editable field, allowing you to manually type in relevant, 

useful data. 
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8.4.2.2 PART II:  LOSS SUMMARY SAMPLE (ARMY VIEW) 

A sample of the Loss Summary worksheet is shown below. 
 

 

Figure 8–10:  Part II:  Loss Summary Sample (Army View) 

8.4.2.3 DATA DEFINITIONS FOR LOSS SUMMARY SECTION (MARINE VIEW) 

The following are the definitions for the data columns contained on the summary portion of Part 
II of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
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– NOV represents November 
– 04 represents the year 

 Person Type—Person Types can be one of the following:  DOD Contractor, DOD 
Federal Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 PMOS—This is the Primary Military Occupational Specialty of the individual gain or 
loss during this reporting period. 

 Grade/Skill Level—This represents the grade or skill level for the individual loss during 
this reporting period. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

 Loss Type—The Loss Type column of the Loss Summary page identifies the action or 
event that caused the person to become a loss.  The following is a listing of the possible 
loss types and their meanings: 
– DEL—This loss type is displayed when: 

 The person’s record is deleted.  The following events cause the deletion of a 
person’s record: 
– A Mobile system user submits the Delete Person action to delete a person’s 

record. 
– A reassignment action causes the Mobile system to lose visibility of the 

person’s record. 
 The person is reassigned.  If a Mobile system user submits an Correct DASUIC 

action for a person’s record, DEL is displayed as the loss type for the losing unit.   
– ATCH—This loss type is displayed for the following attachment-related losses: 

 Assigned unit.  When a person is attached out, ATCH is displayed as the loss 
type for the assigned unit. 

 Attached unit.  When a person’s attachment is released or deleted, ATCH is 
displayed as the loss type for the attached unit. 

– The loss type for duty status-related losses is the duty status itself.  For example, if a 
person’s duty status is changed to RNR, then the loss type will be RNR. 

 Total—This is the total number for each line of information 
 Remarks—This block is an editable field, allowing you to manually type in relevant, 

useful data. 
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8.4.2.4 PART II:  LOSS SUMMARY SAMPLE (MARINE VIEW) 

A sample of the Loss Summary worksheet is shown below. 
 

 

Figure 8–11:  Part II:  Loss Summary Sample (Marine View) 

8.4.2.5 DATA DEFINITIONS FOR LOSS DETAIL SECTION (ARMY VIEW) 

The following are the definitions for the data columns contained on the detail portion of Part II 
of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 
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 Name—This is the name of the individual gain or loss during this reporting period. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual gain or loss during this reporting period. 
 Person Type—This is the Person Type of the individual gain or loss during this reporting 

period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual gain or loss. 
 PMOS/AOC/Series—This is the primary MOS/AOC/Series of the individual gain or 

loss during this reporting period. 
 SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain or 

loss during this reporting period. 
 ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or loss 

during this reporting period. 
 2nd MOS—This is the secondary MOS of the individual gain or loss during this reporting 

period. 
 LANG—This is list of all language identifiers of the individual gain or loss during this 

reporting period. 
 Sex—This is the sex of the individual gain or loss during this reporting period. 
 DDS—This is the deployed duty status of the individual gain or loss during this reporting 

period. 
 DDS Reason—This is the deployed duty status reason code of the individual gain or loss 

during this reporting period. 
 DDS Date—This is the deployed duty status date of the individual gain or loss during 

this reporting period. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 
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8.4.2.6 LOSS DETAIL SAMPLE (ARMY VIEW) 

A sample of the Loss detail worksheet is shown below. 
 

 

Figure 8–12:  Part II:  Loss Detail Sample (Army View) 

8.4.2.7 DATA DEFINITIONS FOR LOSS DETAIL SECTION (MARINE VIEW) 

The following are the definitions for the data columns contained on the detail portion of Part II 
of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
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– 04 represents the year 
 Name—This is the name of the individual gain or loss during this reporting period. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual gain or loss during this reporting period. 
 Person Type—This is the Person Type of the individual gain or loss during this reporting 

period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual gain or loss. 
 PMOS—This is the Primary Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 AMOS—This is the Alternate Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 1st AMOS—This is the First Alternate Military Occupational Specialty of the individual 

gain or loss during this reporting period. 
 LANG—This is list of all language identifiers of the individual gain or loss during this 

reporting period. 
 Sex—This is the sex of the individual gain or loss during this reporting period. 
 DDS—This is the deployed duty status of the individual gain or loss during this reporting 

period. 
 DDS Reason—This is the deployed duty status reason code of the individual gain or loss 

during this reporting period. 
 DDS Date—This is the deployed duty status date of the individual gain or loss during 

this reporting period. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 
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8.4.2.8 LOSS DETAIL SAMPLE (MARINE VIEW) 

A sample of the Loss detail worksheet is shown below. 
 

 

Figure 8–13:  Part II:  Loss Detail Sample (Marine View) 
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8.4.3 Part III:  Gains Summary 

8.4.3.1 DATA DEFINITIONS FOR GAINS SUMMARY SECTION (ARMY VIEW) 

The following are the definitions for the data columns contained on the summary portion of Part 
III of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Person Type—The Person Type is derived from the following data elements:  DoD 
Contractor, DoD Federal Civilian, Foreign National/Military, NAF Employee (AAFES), 
Non-DoD Federal Civilian, Other Civilian, Other US Service Member, Red Cross 
Worker, or US Army Soldier. 

 PMOS/AOC/Series—This is the primary MOS/AOC/Series of the individual during this 
reporting period. 

 Grade/Skill Level—This represents the grade or skill level for the individual during this 
reporting period. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

 Gain Type—This column indicates whether the individual gain was assigned (ASGN), 
attachment-related (ATCH), or assigned and attached (ASGN/ATCH) during the 
reporting period.  Note:  ATCH indicates an attachment gain to the attached unit.  
However, it also indicates a gain back to the assigned unit when the attachment ends. 

 Total—This is the total number for each line of information 
 Remarks—This block is an editable field, allowing you to manually type in relevant, 

useful data. 
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8.4.3.2 PART III:  GAINS SUMMARY SAMPLE (ARMY VIEW) 

A sample of the Gains Summary worksheet is shown below. 
 

 

Figure 8–14:  Part III:  Gains Summary Sample (Army View) 

8.4.3.3 DATA DEFINITIONS FOR GAINS SUMMARY SECTION (MARINE VIEW) 

The following are the definitions for the data columns contained on the summary portion of Part 
III of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 
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 Person Type—The Person Type is derived from the following data elements:  DoD 
Contractor, DoD Federal Civilian, Foreign National/Military, NAF Employee (AAFES), 
Non-DoD Federal Civilian, Other Civilian, Other US Service Member, Red Cross 
Worker, or US Army Soldier. 

 PMOS—This is the Primary Military Occupational Specialty of the individual gain or 
loss during this reporting period. 

 Grade/Skill Level—This represents the grade or skill level for the individual loss during 
this reporting period. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

 Gain Type—This column indicates whether the individual gain was assigned (ASGN), 
attachment-related (ATCH), or assigned and attached (ASGN/ATCH) during the 
reporting period.  Note:  ATCH indicates an attachment gain to the attached unit.  
However, it also indicates a gain back to the assigned unit when the attachment ends. 

 Total—This is the total number for each line of information 
 Remarks—This block is an editable field, allowing you to manually type in relevant, 

useful data. 
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8.4.3.4 PART III:  GAINS SUMMARY SAMPLE (MARINE VIEW) 

A sample of the Gains Summary worksheet is shown below. 
 

 

Figure 8–15:  Part III:  Gains Summary Sample (Marine View) 
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8.4.3.5 DATA DEFINITIONS FOR GAINS DETAIL SECTION (ARMY VIEW) 

The following are the definitions for the data columns contained on the detail portion of Part III 
of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:  221805ZNOV04 
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Name—This is the name of the individual gain or loss during this reporting period. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual gain or loss during this reporting period. 
 Person Type—This is the Person Type of the individual gain or loss during this reporting 

period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual gain or loss. 
 PMOS/AOC/Series—This is the primary MOS/AOC/Series of the individual gain or 

loss during this reporting period. 
 SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual gain or 

loss during this reporting period. 
 ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual gain or loss 

during this reporting period. 
 2nd MOS—This is the secondary MOS of the individual gain or loss during this reporting 

period. 
 LANG—This is list of all language identifiers of the individual gain or loss during this 

reporting period. 
 Sex—This is the sex of the individual gain or loss during this reporting period. 
 DDS—This is the deployed duty status of the individual gain or loss during this reporting 

period. 
 DDS Reason—This is the deployed duty status reason code of the individual. 
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 DDS Date—This is the deployed duty status date of the individual gain or loss during 
this reporting period. 

 Theater Arrival Date—This is the initial arrival date to the theater for the current 
deployment. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

8.4.3.6 GAINS DETAIL SAMPLE (ARMY VIEW) 

A sample of the Gains detail worksheet is shown below. 
 

 

Figure 8–16:  Part III:  Gains Detail Sample (Army View) 
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8.4.3.7 DATA DEFINITIONS FOR GAINS DETAIL SECTION (MARINE VIEW) 

The following are the definitions for the data columns contained on the detail portion of Part III 
of the PERSTAT report: 

 UIC—This is the unit identification code of the reporting unit. 
 Unit Name—This is the corresponding unit name of the UIC. 
 DTG—Date Time Group prepared.  The DTG will be in the following format:  

221805ZNOV04.  The following is an explanation of this format:   
– 22 is the day of the month 
– 1805 is the military time 
– Z represents Zulu 
– NOV represents November 
– 04 represents the year 

 Name—This is the name of the individual gain or loss during this reporting period. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual gain or loss during this reporting period. 
 Person Type—This is the Person Type of the individual gain or loss during this reporting 

period.  Person Types can be one of the following:  DOD Contractor, DOD Federal 
Civilian, Foreign National/Military, NAF Employee(AAFES), Non-DOD Federal 
Civilian, Other Civilian, Red Cross Worker, or United States Marine, US Air Force, US 
Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual gain or loss 
during this reporting period.  The Service Component may be one of the following:  
National Guard, Regular, Reserve, or Unknown. 

 Rank—This is the rank of the individual gain or loss. 
 PMOS—This is the Primary Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 AMOS—This is the Alternate Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 1st AMOS—This is the First Alternate Military Occupational Specialty of the individual 

gain or loss during this reporting period. 
 LANG—This is list of all language identifiers of the individual gain or loss during this 

reporting period. 
 Sex—This is the sex of the individual gain or loss during this reporting period. 
 DDS—This is the deployed duty status of the individual gain or loss during this reporting 

period. 
 DDS Reason—This is the deployed duty status reason code of the individual. 
 DDS Date—This is the deployed duty status date of the individual gain or loss during 

this reporting period. 
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 Theater Arrival Date—This is the initial arrival date to the theater for the current 
deployment. 

 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

8.4.3.8 GAINS DETAIL SAMPLE (MARINE VIEW) 

A sample of the Gains detail worksheet for the Marine view is shown below. 
 

 

Figure 8–17:  Part III:  Gains Detail Sample (Marine View) 

8.4.4 Part IV:  Remarks 

This block is an editable field, allowing you to manually type in relevant, useful data. 
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8.4.4.1 PART IV:  REMARKS SAMPLE 

A sample of the Remarks worksheet is shown below. 
 

 

Figure 8–18:  Part IV:  Remarks Sample 

8.4.5 Business Rules:  PERSTAT Report 

The following business rules apply to the PERSTAT Report: 
 
Part I:  Personnel Daily Summary 

 Only the Missing–Missing in Action (MIS-MIA) duty status is reported in the MIA 
column. 

 The Other Losses column reports the following: 
– Confined by Military Authorities (CMA) 
– Convalescent Leave (CLV) 
– Death Other (DO) 
– Duty Status Where Abouts Unknown (DWU) 
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– Hospitalized (Battle Incurred) (HOW) 
– Hospitalized (Nonbattle Incurred) (HOS) 
– In-Transit (TRA) 
– Missing–Absent Without Leave (MIS-AWL) 
– Missing–Beleaguered (MIS-BGD) 
– Missing–Besieged (MIS-BSG) 
– Missing–Captured (MIS-CAP) 
– Missing–Detained (MIS-DTN) 
– Missing–Interned (MIS-INT) 
– Missing–Missing (MIS-MIS) 
– Redeployed (RED) 
– Rest and Recuperation (RNR) 
– The delete actions that originate from the Mobile and Theater systems. 
– The loss for the losing unit that results from an Correct DASUIC action. 
– The loss that results from an attachment that is ended or deleted. 

 After 24 hours, the following permanent losses are not counted against assigned strength 
and Female columns: 
– Death Other (DO) 
– Killed in Action (KIA) 
– Redeployed–Dropped from Rolls (RED-DFR) 
– Redeployed–Hospitalized (Battle Incurred) (RED-HOW) 
– Redeployed–Hospitalized (Nonbattle Incurred) (RED-HOS) 
– Redeployed–Mission Complete (RED-MIC) 

 
Part II:  Loss Summary 

 Losses reported on both the Loss Summary worksheet and the Losses worksheet include 
all duty status changes except Present for Duty (PDY) and Temporary Duty (TDY). 

 Losses include delete actions that originate from the Mobile and Theater systems. 
 The Correct DASUIC function reports a loss for the losing unit. 
 The data reported on the Loss Summary is only for the preceding 24-hour period. 
 Any action that ends or deletes an attachment is reported as a loss for the losing unit. 

 
Part III:  Gains Summary 

 The data reported on the Gains Summary is only for the preceding 24-hour period. 
 The Correct DASUIC function reports a gain for the gaining unit. 
 Any action that assigns or attaches a person is reported as a gain for the gaining unit. 
 Any action that ends or deletes a person’s individual attachment is reported as a gain to 

the person’s assigned unit. 
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 A unit release action that ends a person’s unit attachment is reported as a gain to the 
assigned higher headquarters unit that was not part of the unit attachment. 

8.5 Unit Roster 

The Unit Roster Report comprises the overall Unit Roster.  The data displayed varies depending 
on whether the Army or Marines view is selected. 

8.5.1 Army View 

8.5.1.1 UNIT ROSTER (ARMY VIEW) 

The following are the definitions for the data columns contained on the Unit Roster worksheet: 
 Name—This is the name of the individual. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual. 
 Person Type—This is the Person Type of the individual.  Person Types can be one of the 

following:  DOD Contractor, DOD Federal Civilian, Foreign National/Military, NAF 
Employee(AAFES), Non-DOD Federal Civilian, Other Civilian, Red Cross Worker, or 
United States Marine, US Air Force, US Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual.  The Service 
Component may be one of the following:  National Guard, Regular, Reserve, or 
Unknown. 

 Rank—This is the rank of the individual. 
 MOS/AOC/Series—This is the MOS/AOC/Series of the individual. 
 SQI—This is a list of all Skill Qualification Identifiers (SQIs) of the individual. 
 ASI—This is a list of all Additional Skill Identifiers (ASIs) of the individual. 
 2nd MOS/AOC—This is a list of the secondary MOS/AOC for the individual. 
 LANG—This is list of all language identifiers of the individual. 
 ASGN/ATCH—This indicates whether the individual is attached or assigned to the 

reporting unit. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 Deployed Assigned Unit Name (DASUIC)—This is the name of the person’s deployed 

assigned unit. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

 Deployed Attached Unit Name (DATUIC)—This is the name of the person’s deployed 
attached unit. 

 DATUIC Arrival Date—This is the arrival date to the unit for the current attachment. 
 HUIC—This is the UIC of the unit the person is assigned to at his or her home station. 
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 Assigned Unit Name (HUIC)—This is the assigned unit name of the unit for the 
individual at his or her home station. 

 MPC—This is the Military Personnel Class code for the soldier and other service 
member. 

 DDS—This is the deployed duty status of the individual. 
 DDS Reason—This is the deployed duty status reason code of the individual. 
 DDS Date—This is the deployed duty status date of the individual. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment. 
 Phys. Loc.—This is the physical location of the individual. 
 Phys. Base Camp—This is the location of the individual’s base camp. 
 Phys. Country—This is the country associated with the individual’s physical location. 
 Phys. Location Arrival Date—This is the arrival date to the current location of the 

individual. 
 ASGN Loc—This is the individual’s assigned location. 
 ASGN Base Camp—This is the assigned base camp for the individual. 
 ASGN Country—This is the assigned country for the individual. 
 ASGN Location—This lists the individual’s assigned location. 
 ASGN Location Arrival Date—This is the arrival date to the assigned location of the 

individual. 
 Sex—This is the sex of the individual. 
 HOR City—This is the home of record (HOR) city for the individual. 
 HOR State—This is the home of record (HOR) State for the individual. 
 Marital Status—This is the marital status of the individual. 
 Military Education Level—This is the military education level of the individual. 
 Religious Denomination—This is the religious denomination of the individual. 
 Race—This is the race population code for the individual. 
 Ethnic Group—This is the code for the individual’s ethnic group. 
 Blood Type—This is the blood type of the individual. 
 Date of Birth—This is the date of birth for the individual. 
 DEROS Date—This is the Date Eligible to Return from Overseas (DEROS) for the 

individual. 
 Security Clearance Level—This is the security clearance level for the individual. 
 Security Clearance Level Code—This code indicates the level of security clearance the 

individual has been granted. 
 Security Clearance Date—This is the date the individual’s security clearance was 

granted. 
 TAPDB Record Status Code—This code indicates the record status of individual. 
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 Operation—The title of the operation to which the individual is assigned. 
 Admission Date—This is the date the individual was admitted to a medical treatment 

facility. 
 Discharge Date—This is the date on which the individual was discharged from a 

medical treatment facility. 
 Hospital Description—This lists the hospital name. 
 Status Description—This indicates whether the individual is in-patient or out-patient. 
 Destination Description—This provides information on where the patient will be sent 

for treatment. 
 Condition Description—This provides a brief description as to the individual’s 

condition. 
 Patient Disposition 
 Remarks—This field lists any remarks regarding the individual’s medical treatment. 
 Tour Status—This indicates the individual’s status relative to completion of a tour of 

duty in a location outside the boundaries of the continental United States. 
 Sub Tour Status—This designates a subtype of tour status. 
 Tour Days—This provides a count, in days, of the length of the individual’s tour. 
 Tour Effective Date—This is the calendar date on which the individual’s tour of duty 

began. 

8.5.1.1.1 UNIT ROSTER REPORT SAMPLE (ARMY VIEW) 

DTAS displays the Unit Roster Report in an Excel spreadsheet template.  Because of the width 
of the report, you may want to print the report as multiple pages, as shown in the sample below, 
in order to produce a legible report.   
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Figure 8–19:  Unit Roster—Page 1 (Army View) 
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Figure 8–20:  Unit Roster—Page 2 (Army View) 
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Figure 8–21:  Unit Roster—Page 3 (Army View) 
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Figure 8–22:  Unit Roster—Page 4 (Army View) 
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Figure 8–23:  Unit Roster—Page 5 (Army View) 
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Figure 8–24:  Unit Roster—Page 6 (Army View) 

8.5.1.2 COMPONENT TAB (ARMY VIEW) 

The Component tab provides you with a pivot table that lists personnel assigned to your unit by 
assigned location and service component.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 Component Section—Using the Component picklist, you can select the components for 

which you would like to display data.  The report displays columns only for those 
components you have selected. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 
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Figure 8–25:  Component Tab (Army View) 

8.5.1.3 RESERVE TAB (ARMY VIEW) 

The Reserve tab provides you with a pivot table that lists Reserve soldiers assigned to your unit.  
The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Tour Status—This picklist allows you to filter the data by tour status.  The picklist 

defaults to All. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
– Sub Tour Status—This allows you to select a Sub Tour Status for which to display 

data. 
 DOD Component—Using the DOD Component picklist, you can select the Department 

of Defense components for which you would like to display data.  The picklist defaults to 
Show All. 

 Service Component—Using the Service Component picklist, you can select the service 
component (such as, Active, Reserve, or Guard) for which you would like to display data.  
The picklist defaults to Reserve. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 
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Figure 8–26:  Reserve Tab (Army View) 

8.5.1.4 GUARD TAB (ARMY VIEW) 

The Guard tab provides you with a pivot table that lists National Guard soldiers assigned to your 
unit.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 DOD Component—Using the DOD Component picklist, you can select the Department 

of Defense components for which you would like to display data.  The picklist defaults to 
Show All. 

 Service Component—Using the Service Component picklist, you can select the service 
component (such as, Active, Reserve, or Guard) for which you would like to display data.  
The picklist defaults to National Guard. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 

 

Figure 8–27:  Guard Tab (Army View) 
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8.5.1.5 FEMALE TAB (ARMY VIEW) 

The Female tab provides you with a pivot table that lists female personnel assigned to your unit 
by assigned location and service component.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 Component Section—Using the Component picklist, you can select the components for 

which you would like to display data.  The report displays columns only for those 
components you have selected.  The report displays a component column and a 
component total column for each component selected. 

 Sex—This picklist allows you to select the gender for which you would like to display 
data.  This defaults to Female.  The sex selected is displayed at the top of each 
component column. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 

 

Figure 8–28:  Female Tab (Army View) 

8.5.1.6 OPERATION TAB (ARMY VIEW) 

The Operation tab provides you with a pivot table that lists personnel assigned to your unit by 
assigned location and operation.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
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– ASGN Base Camp—This picklist allows you to select an assigned base camp for 
which to display data. 

 Operation—Using the Operation picklist, you can select the operations for which you 
would like to display data.  The report displays columns only for those operations you 
have selected.   

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 

 

Figure 8–29:  Operation Tab (Army View) 

8.5.1.7 PERMANENT PARTY TAB (ARMY VIEW) 

The Permanent Party tab provides you with a pivot table that lists personnel assigned to your unit 
by assigned location and tour status.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 Component—Using the Component picklist, you can select the components for which 

you would like to display data.  The report displays columns only for those components 
you have selected.  The report displays a component column and a component total 
column for each component selected. 

 Tour Status—This picklist allows you to select the tour status for which you want to 
display data.  The picklist defaults to Permanent Party. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 
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Figure 8–30:  Permanent Party Tab (Army View) 

8.5.1.8 BLANK TAB (ARMY VIEW) 

This worksheet provides you with a customizable pivot table.  To select the criteria for your 
report, drag and drop the data items from the Pivot Table Field List window to the appropriate 
section of the report.  Alternatively, you can select the data item from the list, select the display 
area, and click the Add To button.  The system populates the data fields as you drop them on to 
the table. 
 

 

Figure 8–31:  Blank Tab (Army View) 
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8.5.2 Marine View 

8.5.2.1 UNIT ROSTER (MARINE VIEW)  

The following are the definitions for the data columns contained on the Unit Roster: 
 Name—This is the name of the individual. 
 SSN/GUID—This is the Social Security number or global unique identifier (GUID) of 

the individual. 
 Person Type—This is the Person Type of the individual.  Person Types can be one of the 

following:  DOD Contractor, DOD Federal Civilian, Foreign National/Military, NAF 
Employee(AAFES), Non-DOD Federal Civilian, Other Civilian, Red Cross Worker, or 
United States Marine, US Air Force, US Army Soldier, US Coast Guard, or US Navy. 

 DoD Component—This may contain one of the Department of Defense Component 
codes. 

 Service Component—This is the Service Component of the individual.  The Service 
Component may be one of the following:  National Guard, Regular, Reserve, or 
Unknown. 

 Rank—This is the rank of the individual. 
 MOS/AOC/Series—This is the MOS/AOC/Series of the individual. 
 AMOS—This is the Alternate Military Occupational Specialty of the individual gain or 

loss during this reporting period. 
 1st AMOS—This is the First Alternate Military Occupational Specialty of the individual 

gain or loss during this reporting period. 
 LANG—This is list of all language identifiers of the individual. 
 ASGN/ATCH—This indicates whether the individual is attached or assigned to the 

reporting unit. 
 DASUIC—This is the Deployed Assigned Unit Identification Code for the individual. 
 Deployed Assigned Unit Name (DASUIC)—This is the name of the person’s deployed 

assigned unit. 
 DATUIC—This is the Deployed Attached Unit Identification Code for the person.  If the 

person is both individually attached and unit attached, the UIC displayed in the DATUIC 
column is the unit to which the person is individually attached. 

 Deployed Attached Unit Name (DATUIC)—This is the name of the person’s deployed 
attached unit. 

 DATUIC Arrival Date—This is the arrival date to the unit for the current attachment. 
 PRUC—This is the Primary Reporting Unit Code. 
 PRUC Unit Name (PRUC)—This is the name associated with the Primary Reporting 

Unit Code. 
 MPC—This is the Military Personnel Class code for the soldier and other service 

member. 
 DDS—This is the deployed duty status of the individual. 
 DDS Reason—This is the deployed duty status reason code of the individual. 
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 DDS Date—This is the deployed duty status date of the individual. 
 Theater Arrival Date—This is the initial arrival date to the theater for the current 

deployment. 
 Individual Location—This is the location of the individual. 
 INDV Base Camp—This is the location of the individual’s base camp. 
 INDV Country—This is the country associated with the individual’s location. 
 INDV Location Arrival Date—This is the arrival date to the location of the individual. 
 ASGN Loc—This is the individual’s assigned location. 
 ASGN Base Camp—This is the assigned base camp for the individual. 
 ASGN Country—This is the assigned country for the individual. 
 ASGN Location Arrival Date—This is the arrival date to the assigned location of the 

individual. 
 Sex—This is the sex of the individual. 
 HOR City—This is the home of record (HOR) city for the individual. 
 HOR State—This is the home of record (HOR) State for the individual. 
 Marital Status—This is the marital status of the individual. 
 Military Education Level—This is the military education level of the individual. 
 Religious Denomination—This is the religious denomination of the individual. 
 Race—This is the race population code for the individual. 
 Ethnic Group—This is the code for the individual’s ethnic group. 
 Blood Type—This is the blood type of the individual. 
 Date of Birth—This is the date of birth for the individual. 
 OPID—This is the Operational Identifier for the individual. 
 MAGTF—This is the Marine Air-Ground Task Force to which the individual is 

assigned. 
 Operation—The title of the operation to which the individual is assigned. 
 Tour Status—This indicates the individual’s status relative to completion of a tour of 

duty in a location outside the boundaries of the continental United States. 
 Sub Tour Status—This designates a subtype of tour status. 
 Tour Days—This provides a count, in days, of the length of the individual’s tour. 
 Tour Effective Date—This is the calendar date on which the individual’s tour of duty 

began. 

8.5.2.1.1 UNIT ROSTER REPORT SAMPLE (MARINE VIEW) 

DTAS displays the Unit Roster Report in an Excel spreadsheet template.  Because of the width 
of the report, you may want to print the report as two pages, as shown in the sample below, in 
order to produce a legible report.   
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Figure 8–32:  Unit Roster—Page 1 (Marine View) 
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Figure 8–33:  Unit Roster—Page 2 (Marine View) 
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Figure 8–34:  Unit Roster—Page 3 (Marine View) 
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Figure 8–35:  Unit Roster—Page 4 (Marine View) 
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Figure 8–36:  Unit Roster—Page 5 (Marine View) 

 
 

Figure 8–37:  Unit Roster—Page 6 (Marine View) 

8.5.2.2 COMPONENT TAB (MARINE VIEW) 

The Component tab provides you with a pivot table that lists personnel assigned to your unit by 
assigned location and service component.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
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 Component Section—Using the Component picklist, you can select the components for 
which you would like to display data.  The report displays columns only for those 
components you have selected. 

 

 

Figure 8–38:  Component Tab (Marine View) 

8.5.2.3 RESERVE TAB (MARINE VIEW) 

The Reserve tab provides you with a pivot table that lists Reserve soldiers assigned to your unit.  
The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Tour Status—This picklist allows you to filter the data by tour status.  The picklist 

defaults to All. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
– Sub Tour Status—This allows you to select a Sub Tour Status for which to display 

data. 
 DOD Component—Using the DOD Component picklist, you can select the Department 

of Defense components for which you would like to display data.  The picklist defaults to 
Show All. 

 Service Component—Using the Service Component picklist, you can select the service 
component (such as, Active, Reserve, or Guard) for which you would like to display data.  
The picklist defaults to Reserve. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 
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Figure 8–39:  Reserve Tab (Marine View) 

8.5.2.4 GUARD TAB (MARINE VIEW) 

The Guard tab provides you with a pivot table that lists National Guard soldiers assigned to your 
unit.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 DOD Component—Using the DOD Component picklist, you can select the Department 

of Defense components for which you would like to display data.  The picklist defaults to 
Show All. 

 Service Component—Using the Service Component picklist, you can select the service 
component (such as, Active, Reserve, or Guard) for which you would like to display data.  
The picklist defaults to National Guard. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 

 

Figure 8–40:  Guard Tab (Marine View) 
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8.5.2.5 FEMALE TAB (MARINE VIEW) 

The Female tab provides you with a pivot table that lists female personnel assigned to your unit 
by assigned location and service component.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 Component Section—Using the Component picklist, you can select the components for 

which you would like to display data.  The report displays columns only for those 
components you have selected.  The report displays a component column and a 
component total column for each component selected. 

 Sex—This picklist allows you to select the gender for which you would like to display 
data.  This defaults to Female.  The sex selected is displayed at the top of each 
component column. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 

 

Figure 8–41:  Female Tab (Marine View) 

8.5.2.6 OPERATION TAB (MARINE VIEW) 

The Operation tab provides you with a pivot table that lists personnel assigned to your unit by 
assigned location and operation.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
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– ASGN Base Camp—This picklist allows you to select an assigned base camp for 
which to display data. 

 Operation—Using the Operation picklist, you can select the operations for which you 
would like to display data.  The report displays columns only for those operations you 
have selected.   

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 

 

Figure 8–42:  Operation Tab (Marine View) 

8.5.2.7 PERMANENT PARTY TAB (MARINE VIEW) 

The Permanent Party tab provides you with a pivot table that lists personnel assigned to your unit 
by assigned location and tour status.  The report displays the following data: 

 Deployed Duty Status—This picklist defaults to Present for Duty. 
 Location/Component Section—This section displays the following (to display the 

selected values, double click the column heading and then select and double click on the 
value from the pop-up list: 
– ASGN Country—This picklist allows you to select an assigned country for which to 

display data. 
– ASGN Base Camp—This picklist allows you to select an assigned base camp for 

which to display data. 
 Component—Using the Component picklist, you can select the components for which 

you would like to display data.  The report displays columns only for those components 
you have selected.  The report displays a component column and a component total 
column for each component selected. 

 Tour Status—This picklist allows you to select the tour status for which you want to 
display data.  The picklist defaults to Permanent Party. 

 Grand Total—This column provides a tally of all personnel who meet your search 
criteria. 

 



DTAS Mobile Application User Manual CM No.  DTAS-MAUM0-033-20080114 

8–60 
January 14, 2008 Draft (Version 3.3) 

FOR OFFICIAL USE ONLY 

 

Figure 8–43:  Permanent Party Tab (Marine View) 

8.5.2.8 BLANK TAB (MARINE VIEW) 

This worksheet provides you with a customizable pivot table.  To select the criteria for your 
report, drag and drop the data items from the Pivot Table Field List window to the appropriate 
section of the report.  Alternatively, you can select the data item from the list, select the display 
area, and click the Add To button.  The system populates the data fields as you drop them on to 
the table. 
 

 

Figure 8–44:  Blank Tab (Marine View) 
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9. MANAGEMENT TAB 

The Management tab allows you to manage personal equipment issued to an individual, such as 
night vision goggles (NVGs) and weapons.  To update information for an individual, perform the 
following steps: 
1. Place the cursor in the column you wish to update for the applicable individual and click the 

left mouse button.  For example, to update a serial number for night vision goggles, place the 
cursor in the NVG Serial # column. 

 

 

Figure 9–1:  Management Tab 

2. Enter the data you wish to update.  
3. When you have finished entering the data, click Save to save the changes. 
4. DTAS displays a confirmation message if the update is successful. 
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Figure 9–2:  Save Confirmation Message 

 
Note:  If the system detects that there have been no updates, DTAS displays the ―There are no 
updates to perform‖ message when you click the Update button. 
 

 

Figure 9–3:  No Updates Message 
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10. DCIPS-FORWARD EXPORT 

The DTAS Mobile application provides a refresh of data used in the Defense Casualty 
Information Processing System Forward (DCIPS-Forward).  DCIPS-Forward is a casualty 
reporting system that is designed to work in situations where e-mail or Internet access is 
unavailable.  The system allows users to create casualty reports locally and, when e-mail access 
is restored, send the information to the casualty office for upload to the main DCIPS database. 
 
The DTAS DCIPS-Forward refresh process runs every 4 hours and is transparent.  DTAS 
exports the data to the df_personnel.mdb MS Access database file.  DTAS exports data for all 
personnel contained on your local DTAS database.  The data elements exported include the 
following: 

 SSN 
 Last Name 
 First Name 
 Middle Name 
 Rank 
 Unit  
 UIC 
 PMOS 
 PEBD 
 BASD 
 Grade 

 
Once the export process is complete, you must then copy the df_personnel.mdb file to the 
directory in which DCIPS-Forward is located on your PC.  You can turn the process off by 
changing the job enabled setting in the DCIPS_Export.ini file from JOB_ENABLED=true to 
JOB_ENABLED=false.  Note:  The JOB_ENABLED keyword is case-sensitive.  If the refresh 
process fails, DTAS creates a log file. 
 
Refer to the USMC DCIPS Forward Support Page for additional information and directions on 
how to install DCIPS-Forward.  The site is located at 
https://143.84.96.35/dcips/usmc/dcipsforward/usmc_dcipsforward.htm.   
 
Information on DCIPS-Forward for Army personnel can be found at http://usassi-
www.army.mil/agobc/AG%20Lessons/DCIPS/DCIPS.htm. 
 

https://143.84.96.35/dcips/usmc/dcipsforward/usmc_dcipsforward.htm
http://usassi-www.army.mil/agobc/AG%20Lessons/DCIPS/DCIPS.htm
http://usassi-www.army.mil/agobc/AG%20Lessons/DCIPS/DCIPS.htm
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Glossary 

The following abbreviations and acronyms are used in this document: 
 

Abbreviation/Acronym Definition 

1SG/CO First Sergeant/Company 
1st AMOS First Alternate Military Occupational Specialty 
AAFES Army and Air Force Exchange Service 
AFADBD Armed Forces Active Duty Base Date 
AOC Area of Concentration 
AMOS Alternate Military Occupational Specialty 
APOD Air Port of Debarkation 
APOE Air Port of Embarkation 
ASI Additional Skills Identifier 
BASD Basic Active Service Date 
CDS Cross Domain Solution 
CONUS Continental United States 
CSV Comma Separated Values 
DCIPS-Forward Defense Casualty Information Processing System Forward 
DDS Deployed Duty Status 
DMDC Defense Manpower Data Center 
DoD Department of Defense 
DTAS Deployed Theater Accountability Software 
DTG Date Time Group 
DASUIC Deployed Assigned Unit Identification Code 
DATUIC Deployed Attached Unit Identification Code 
DASUIC Deployed Assigned Unit Identification Code 
DATUIC Deployed Attached Unit Identification Code 
EAS End of Active Service 
eMILPO Electronic Military Personnel Office 
HOR Home of Record 
HUIC Home UIC 
JPERSTAT Joint Personnel Status 
KIA Killed in Action 
LANG Language 
MAGTF Marine Air-Ground Task Force 
MI Middle Initial 
MIA Missing in Action 
MOS Military Occupational Specialty 
MOS/AOC Military Occupational Specialty/Area of Concentration 
MPC Military Personnel Class 
MS Microsoft 
NAF Non-Appropriated Fund  
NVG Night Vision Goggle 
OCONUS Outside the Continental United States 
ODSE Operational Data Store Enterprise 
OPID Operational Identifier 
PC Personal Computer 
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Abbreviation/Acronym Definition 

PEBD Pay Entry Base Date 
PERSTAT Personnel Status 
PMOS Primary Military Occupational Specialty 
POC Point of Contact 
PRUC Primary Reporting Unit Code 
PUIC Parent Unit Identification Code 
R&R Rest And Recuperation 
RUC Reporting Unit Code 
SQI Skill Qualification Indicator 
SSN Social Security Number 
SSN/GUID Social Security Number/Global Unique Identifier 
TPS Tactical Personnel System 
TRN Transfer File 
TRUC Temporary Reporting Unit Code 
UIC Unit Identification Code 
ULN Unit Line Number 
US United States 
USMC U.S. Marine Corps 
WIA Wounded in Action 
XML Extensible Markup Language 

 


